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1. Introduction
Welcome to the Gymnastics ScoreKeeper, the nation’s top gymnastics scoring program. ScoreKeeper has been used to score collegiate gymnastics
meets since 1989 and has been used in all national championships save one since 1991. It has evolved considerable since its debut as a DOS based
program. Now the Windows implementation adds new features and, counter to common wisdom, both faster and easier data entry.
While still not a difficult task, the one area that reflects the greater complexity inherent in a more full-featured program is in the initial program
setup. Chapter 2 is devoted to setting up ScoreKeeper.
Chapter 1 is a short introduction to the ScoreKeeper and describes some of the general features of the program.

Program Navigation
There are two ways to access screens and areas of the program. The primary way to get around is to use the menus. The other is the tool bar, the
row of buttons just below the menu bar.

Menu Navigation
This document frequently refers to screens or to the menus you use to reach them. Menu item text is printed in an italic font with the “>” symbol
connecting succeeding menu items. For example, the following shows the menu selections used to print the team standing report for a meet:
Report » Meet Results » Team Standing
When the reference requires making a selection from a list, the selection will be enclosed in parentheses. For example,
Setup » Meet Templates » (Select Template) » [General Tab]
This example also shows an instruction to select a particular screen tab, in this case the one named “General." Screen tab names will be enclosed in
square brackets and will include the word “Tab.”
When a menu item has a corresponding tool bar button, the button icon will be printed adjacent to the topic heading.
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Tool Bar
The tool bar is a collection of buttons appearing just below the menus. These buttons give you faster access to some of most frequently used
functions.

Open the list of meets.
Open the list of teams for the current meet.
Enter scores for the current meet.
Start timed update of the scoreboard and/or web pages.
Chat between the main program and ScoreKeeper Remote.
Display event results.
Verify judge scores.
Print individual event meet results.
Print the primary official score sheet report.
Print the secondary official score sheet report, if any.
Popup calculator.
Backup the ScoreKeeper data files.
Set the current session on multi-session meets. Normally hidden.
Set the current rotation. This affects what is being sent to scoreboards, etc. It does not directly affect score entry.
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Lists
ScoreKeeper uses a List-Form model to access information. This means that you first see a list of all records of a particular type (e.g. teams in a
meet), then progress to the form to add or change a record. Some lists have tabs across the top. Selecting a different tab changes the order in
which records are sorted. On the team list, for example, you can see teams in name order or in score order.
There are several buttons that are common to most lists in ScoreKeeper.
Insert a new record into the list.
Edit the highlighted record.
Delete the highlighted record.
Select a record when looking up.
Close the window.
Open a context-sensitive help window

Entry Screens
Strange as it may seem, entry screens are where you enter information. Some are tiny with only one piece of data to enter. Others are extensive
with several tabs of settings and entries.
There are a couple of buttons common to most entry screens in ScoreKeeper.
Save changes to the current record or add the record if inserting then close the window.
Close the windows and discard any changes.
Open a context-sensitive help window

Lookups
An entry with the mouse symbol () to the left of the field uses the F2 key or the Right Mouse button to lookup a value or fill a default value into
the field. Sometimes this opens a list from which you can select a record. In the case of date fields, this pops up a calendar where a date can be
selected.

Required Entries
Entry fields that must be filled in have a light blue background. The program will not let you save a screen with an empty required field.
Introduction

Page 3

2. Setting Up ScoreKeeper
ScoreKeeper is an easy program to use and part of the ease comes from properly setting up the program. Setup consists of entering some program
preferences in a couple of places and adding data to some lookup lists. While some of the lists are already populated when ScoreKeeper is installed,
the selections made may not be the ones you want.
IMPORTANT: Don’t want to wait until just before a meet to begin setting up ScoreKeeper. Some of the settings require
some thought and others, for example web page colors, may even require some research on your part. It is
best to give yourself at least several days so you can do your setup in a leisurely fashion instead of
frantically doing everything at the last minute.
If you didn't heed the above warning and absolutely must do your setup at the last moment, here is a brief list of the most important items that
must be addressed before entering your meet.
1.
2.
3.
4.
5.

Program Preferences
Home Team
Seasons
Scoreboards
Customizing Web Pages
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Program Preferences
Setup » Program Preferences
The first step in setting up ScoreKeeper is to set the program preferences. These settings determine how the program operates. The program
preferences screen has several tabs, each with settings you should examine.
NOTE: In earlier versions of ScoreKeeper, the Program Preferences included your web page
settings. These are now described on page 13 under setting up your Home Team.
General Tab
Licensed To
This is a display-only field showing you the institution owning the
ScoreKeeper software license. If this is showing the incorrect name,
please contact Beaver Creek Software.
Meet Location
The first setting in this tab is the meet location. This will be the
default meet location for all of your home meets. This can be
changed for individual meets if necessary.
Program Wallpaper
Ok, this is perhaps an unnecessary feature but you can use it to place
a background image on the ScoreKeeper main screen. There are two
settings a display type and the graphic file to display.
Type
This setting determines how the graphic wallpaper image is
displayed. The possible choices for Type are:
None
No wallpaper.
Centered
Center a graphic image on the screen.
Stretched
Stretch a graphic image to fit the screen.
Tiled
Place as many copies of the graphic image as needed
to fill the screen.
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File Name
When a choice other than None is made for the Type, you can enter a file name or press the ellipsis button to select a graphic image file. You can
select any of the following graphic file formats:
*.bmp
Bitmap or Windows Paint file
*.gif
Graphic Interchange Format
*.ico
Icon file
*.jpg
JPEG file
*.pcx
Paintbrush file
*.wmf
Windows Metafile
Color Preferences
The color preferences let you select foreground text and background colors used to indicate the different performance types for gymnasts when
setting lineups. You can also set the colors for the score entry field when entering scores.
Unless you have a hard time seeing the different colors, leave these alone until you have had a chance to see how they work in practice.
Allow ScoreKeeper Remote users to change lineups
If you want people entering scores via ScoreKeeper Remote to be able to change lineups, check this box. Usually, this is reserved for the operator
of the main ScoreKeeper program.
Allow ScoreKeeper Remote users to enter Team Neutral Deductions
If you want people entering scores via ScoreKeeper Remote to be able to enter team neutral deductions, check this box. Because team neutral
deductions are not well understood by casual users, this is usually reserved for the operator of the main ScoreKeeper program.

Setting Up ScoreKeeper

Page 6

Scoreboard Tab
This tab is for display scoreboards that can receive and display live
data via a serial port or by polling a file. Currently ScoreKeeper can
send output directly to Daktronics and White Way scoreboards. Elite
Technologies scoreboards are controlled by their own software that
interacts with ScoreKeeper.
Additional scoreboard settings are contained in the scoreboard
definition records which are discussed on page 72.
Scoreboard Interface
Select Serial Communications send data via the computer’s serial (RS232) port. When checked, it will enable the Serial Communications
fields. Select DDE (Elite Scoreboards) to enable ScoreKeeper to
communicate to Elite Technologies scoreboard and data entry
software through a ScoreKeeper DDE (Dynamic Data Exchange)
server.
Select Other if you are using either XML or Video output to control
scoreboard displays
Comm Port
Serial communications ports are numbered from 1 to 4 although
special hardware can add higher numbered ports. Usually you will
select port 1 unless that port has already been assigned to a modem in which case you would probably choose port 2. ScoreKeeper does not make
a port available to the computer; it must already be available for ScoreKeeper to use.
To see what ports your computer has, look at the device manager in the System Information program in your Windows Control Panel.
Baud Rate
This tells ScoreKeeper the speed in which it should send scoreboard data. This setting must match the speed setting at the other end of the
communications link, namely the scoreboard computer.
Parity
This is a very simple error detection protocol and must match the parity setting of your scoreboard’s computer. The most common value is None.
Data Bits
This setting how many bits of each data package are used for actual data. Again, this must match the setting on your scoreboard’s computer. The
most common value is 8.
Setting Up ScoreKeeper

Page 7

Stop Bits
Nobody really cares what stop bits means. It is just another arcane serial communication setting that must match on your scoreboard’s computer.
The usual value is 1.
Send Scoreboard Results to a File
Check this box if you want the scoreboard results sent to a file in addition to or instead of sending the data via serial communications. When using
serial communications, sending the results to a file can be useful if you are having problems with the data layout and want to view the actual
contents of the communicated data.
File Name
If sending scoreboard results to a file, enter a path and file name here or press the ellipsis button to select a file.
In the Displaying "All Around" on scoreboard final results box are two fields ScoreKeeper needs to know when sending all around scores to the
scoreboard. Since All Around is not in itself an event, ScoreKeeper needs to know what text to send to the scoreboard to indicate the all around
results when sending final results to the scoreboard.
Short Name
This text is sent, just like an event short name (e.g. VAULT) when sending all around results.
Abbreviation
If your scoreboard definition specifies sending a two character event abbreviation, this entry specifies the abbreviation for the all around “Event.”
Flasher Boards: Display Seconds
If you are using ScoreKeeper Flasher digital displays, this setting determines how long to display the scores for one gymnast before clearing the
display and showing the event name. Set this to zero to show the scores continuously and not revert to the event name display.
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Reports & XMLTab
The report settings on this tab affect all reports in ScoreKeeper.
Graphic Adjustment
All of the reports in ScoreKeeper have at least one graphic element
such as a line or box. Different Windows printer drivers handle
positioning graphic and text elements differently. This can result in
text being either too high or too low relative to the lines and boxes.
The differences are small and on most reports would be
unnoticeable. However on the official score sheet reports, the text
and graphic elements are very tightly registered and a small variation
can make a big difference.
ScoreKeeper lets you set a value used to move graphic elements up
or down. The value is in 1/1000 of an inch. Positive values move
graphics up while negative values move them down. Start small with
your adjustments then try a larger one if needed. Use the official
score sheet report as your test because it is the most sensitive to
changes.
XML Output
The XML Output settings are described on page 80.

Home Teams

Setup » Home Teams
ScoreKeeper offers the option to have multiple home teams. If
you have purchased this option, you can use it to have, for
example, both a men’s and women’s teams.
When you click the
button at the bottom screen to add a
new home team, the first screen you see is a list of meet
templates. Click
to select the template to use as a default
for new meets.

Setting Up ScoreKeeper

Page 9

General Tab
Team Type
Select either a women's or men's team. If you have licensed only one
of these, it will be the only choice available.
Name
This is a name identifying this home team to users of ScoreKeeper. It
never appears on meet reports, web pages, or scoreboards. It does
appear on home team statistics reports.
Meet Team Name
This is the name for your home team when entered in a meet.
Short Name
This is the short version of the team name used on scoreboards and
some other output where space is limited.
Head Coach
The head coach name appears on score sheets and web pages.
Team Record Scores
For team total, individual all-around and each event you can enter
the record scores for the home team. This should only need to be
done once on initial setup because ScoreKeeper will update these for
you when you enter scores for a meet.
To add or change individual and team records for each event, double
click on the event or highlight the event and click the
button.
Show home team records on meet results reports
Check this box if you would like ScoreKeeper to print a legend on individual event and all-around reports when members of your home team set
or tie a personal or team record.
Show home team records on screen when entered
Check this box if you would like ScoreKeeper to alert the user when entering a score that sets or ties a personal or team record.
Default Meet Template
Select a meet template that will be the default template selected when adding a meet for this home team.
Setting Up ScoreKeeper
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Gymnasts Tab
The apparent simplicity of this tab hides a powerful tool for managing your home
team gymnasts. With it you can edit and/or view the gymnasts on the home
team for any season. This allows you to keep data from past seasons for review
at any time.
The Season drop-list shows you a list of available seasons. If nothing is shown or
if you are starting a new season and it is not yet listed, click on the green dot
button on the right of the drop-list. This will take you to an open-ended list of
seasons where you can add one. Seasons are discussed more fully starting on
page 16.
The list of gymnasts shows those who are team members on the season shown
above. When starting a new season, it is easy to add gymnasts from the current
season to the new season. There are even three ways to do it, two from this
screen and one from the Home Team Gymnast screen.
Adding a Current Gymnasts to a New Season
To add gymnasts to a new season, highlight a gymnast and press the Add to New
Season button. You are first presented with a list of seasons. Add one to the list
if necessary then select the new season. Next decide whether you want to add
the entire team or only the selected gymnast. If you add the whole team to a
new season you can delete those few who are no longer on the active team. This
is often quicker than adding gymnasts one at a time.
Adding a New Gymnast
To add a brand new gymnast to your home team, press the Insert key or click the
plus button to add them. When you add or edit a gymnast, you will be presented with the Home Team Gymnast entry form.
This example screen shows how it looks when filled with information. When adding a new gymnast, of course, it will be mostly empty until you do
your magic and enter the information.
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First Name
Last Name
Enter the gymnast’s first and last names in the respective fields.
Competition Number
If your home team uses their own competition numbers during regular season meets, enter
those numbers here. They will be used when a new meet is created.
Grade Point Average
If you want to track your gymnasts GPA, enter it here.
Career Total Points
If you need to track a gymnasts career total points, you can have ScoreKeeper calculate it based
on all of the meets you have entered. Click the Recalculate button. This value will be recalculated
automatically when you print the home team statistics report.
Team Membership
This list shows the seasons in which the gymnast was a team member. You can add the gymnast
to or delete the gymnast from a season by using the
or
button respectively.
Personal Records
For all-around and each individual event, enter the gymnast’s highest score or press the Recalculate Records button to let the program determine
the values based on the meets entered. To enter an event record score, double-click on the event.
If you enter a value higher than what the program finds, it will use the higher number. This is useful if ScoreKeeper does not have all the data for
this gymnast.
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Web Pages Tab
ScoreKeeper can automatically create a web page of your meet results each time
a score is entered. On this tab, you specify the name and location of the web
page file and some options on what to generate. You can also generate a web
page of your current season’s home team statistics. Enter a file name, with
optional field tokens, for each.
In addition to the settings on this tab, there are more web page settings on the
Page Format tab. Other options you can use to customize your meet result web
pages are discussed in detail beginning on page 108.
Live Scores File Name
Team Stats File Name
Enter the name of the web page file you want ScoreKeeper to create. The Live
Scores File Name in the above sample screen shows the effect of the four
replaceable tokens in the Example text below the entry field. They represent
the name of a file that would be generated on October, 16, 2009.
Path
Enter the complete path to where you want ScoreKeeper to place the web
page file. This can be on any drive or network location accessible to the scoring
computer. You can use the ellipses button to browse for a destination path.
Generate HTML Header
If this is checked, ScoreKeeper will add a title and several Meta tags between
the <head> and </head> HTML tags. If not checked neither the <head> and
</head> tags nor the title and Meta tags are generated.
Some Internet Service Providers such as Fans Only add their own header. If this is the case, leave this unchecked.
Seconds for HTML Refresh
Entering a non-zero number here results in a parameter embedded in your web page that tells a web browser viewing this page how often to
automatically go to your web site and reread the page. You can enter any value from 0 to 9999 seconds. Entering 0 disables this feature.
Include listing of the meet judges
Check this box if you want your web pages to list the judges for each event.
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Include competition order and judge scores as popups
A picture showing this feature gives a better idea than a description alone. The image on the right is from an actual
meet web page with details enabled. When the viewer hovers his or her mouse over a score in either the team details
or event results areas. In the sample image, the mouse is hovered over 9.825 and the orange bordered box shows the
order in which the gymnast competed and the scores from each judge. For FIG style scoring, the D score is also shown.
Home Page Address Link
When ScoreKeeper creates a meet results web page, it can place a link to your home team's home page. If you want to include this link, enter the
full address to the page here. You can use either an absolute or relative address for the link. If you use an absolute link, be sure to include the full
path name including the leading "http://" and the page file name.
Export Internet Information Button
This button exports your Home Page Address Link.
Page Format Tab
Format web pages with CSS Styles
Scorekeeper gives you two ways to make the web pages it creates look the way
you want. The "old" way is to create pages where each page element contains
the formatting information for that element. This includes colors, spacing, etc.
The second way is to include only the basic information on the page along with
labels for the different kinds of elements. The actual formatting is done using a
separate "Style Sheet." Style sheets allow for a more modern appearance and
are the standard for web sites today.
Checking this box means that you have to have a style sheet or your pages will
look very bad indeed! We have provided you with two sample style sheets and
you can use them as-is or modify them to your needs.
Color Preferences
If you are using style sheets, most of these selections will be disabled. Only the
last, "Details Popup" will be available.
When not using a style sheet, you can customize the appearance of your web
pages by modifying the color palette. Judicious use of your school colors can
result in a very attractive page.
In addition to showing you the actual selected colors, the color values will be
displayed in either groups of three hexadecimal (base 16) or decimal numbers.
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Use the Decimal color numbers check box to view color number is decimal instead of hexadecimal. To confuse matters further, web pages use
hexadecimal color numbers but the Microsoft color selector uses decimal numbers. The first set of 2 hexadecimal digits or three decimal digits
represents the red component. The second set represents the green component and the third set represents the green component. Values of
each set can be from 0 to 255 (0 to FF in hexadecimal).
Hexadecimal numbers are in base 16 using the digits 0-9 and the letters A-F where A is 10, B is 11, etc. When used in a web page, color values will
appear as a single six digit hexadecimal number preceded by a pound symbol (#). For example #000000 is black (no red, green, or blue), #FFFFFF is
white (FF = 255, the maximum value for each component color), #00FF00 is bright green and, #009900 is a darker green.
Text buttons
These buttons allow you to select the color of the foreground text for the associated display type.
Background buttons
These buttons allow you to select the background color for the associated display type.
Reset buttons
These buttons reset the background and foreground colors to the program default values in case you get hopelessly lost in color-land.
When you press a text or background button, you are taken to the Windows color selection window. This window lets you choose from a palette of
standard colors or you can press the Define Custom Color button on the color dialog window to independently select the red, green, and blue
components. These are decimal values that can range from 0 to 255.
If you don’t know the color values for your school colors, you can probably get them by opening up your school web page and looking at the source
code (in Internet Explorer choose: View » Source) and look for color values in the format described above. Better still, ask someone who knows.
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FTP Tab
Because different home teams are likely to have different internet pages, some
internet web settings that might seem to be more logically placed with the
Program Preferences are found on the home team entry screen.
NOTE: The Enable Web Page Uploads check box on the
Web Pages menu must be checked to actually upload
your web pages.
FTP Username
FTP Password
If you want ScoreKeeper to automatically upload your web pages to your web
server or ISP, enter your FTP login user name and password here. You may
need to get these from your system administrator.
When you enter a password, you will be asked to enter it again to confirm it.
FTP Live Scores Web Page Host Name
Enter the FTP host or server name to which you want to upload your live meet
web pages. This is usually something like ftp.teamname.com. It does not include any path or directory information. That information goes into
the next entry.
FTP Live Scores Web Page Directory
Enter here the complete path to where you are uploading your web page. This usually starts with a slash (/) and uses subsequent slashes to
separate each folder or directory level. Be sure to use forward slashes (/) and not back slashes (\).
FTP Home Team Stats Web Page Host Name
FTP Home Team Stats Web Page Directory
These work just like the settings above for live scores. The directory, however, may be different.
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Advanced FTP Options
Click this button to modify some advanced FTP settings.
Use Proxy / Proxy Name
If you are using a Proxy server or firewall, check the box and enter the proxy
host name or address.
Port Number
This is the port to connect to on the FTP site. This is normally 21; however, it
may be something different if you are going through a firewall, or if the site
administrator has assigned the FTP service to a non-standard port.
Transfer Type
ASCII – Used for text file transferring. All ScoreKeeper web pages are text unless you have an include file containing something other than text.
Binary – Binary mode is used for transferring files that are not text (e.g., executable programs, word processing documents, spreadsheets,
databases, graphics files, and sound files).
Auto Detect – Let the FTP routines determine the transfer type.
Open Mode
Passive – Use Passive if you want your PC to establish the data connection to the FTP site instead of the site establishing the data connection to
your PC. This is recommended for most FTP sites, and it is absolutely necessary for some firewall and gateway configurations and when you get
failed data channel errors. Passive mode is an asynchronous process (see below). Note, however, that not all FTP sites support passive mode.
Passive mode may be required in the following instances:
1.
2.
3.
4.

For users on networks behind some types of router-based firewalls,
Users on networks behind a gateway requiring passive transfers,
If transfers are erratic,
If you keep getting failed data channel errors.

Asynchronous – Asynchronous transfer operations occur independently of other procedures. Thus, in asynchronous mode, ScoreKeeper can
continue running while data is transferred in the background. Since the FTP transfer is running in its own execution thread this has little practical
effect.
Synchronous – In synchronous mode, file transfer operations occur before any other procedures are executed. Thus the data transfer must be
completed before any ScoreKeeper can continue. Since the FTP transfer is running in its own execution thread this has little practical effect.
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Email Tab
When a meet is finalized, ScoreKeeper can send meet results as email
attachments to a list of email addresses.
Email Server
To enable sending results when meets are finalized, select either the
Default or My Institution email address. Your choice determines
whether you use Beaver Creek Software's email server or your own.
Selecting Default to use the Beaver Creek Software email server
disables and skips the next four fields.
SMTP Server
Enter the address of your SMTP server. This is usually something like
smtp.myschool.edu (but don't use the example, it won't work).
User Name
This is the name used to login to the SMPT server.
Password
This is the password required to login to the SMPT server.
SMTP Port
Unless you have been instructed to use a different port, this should
be 25. The other common port is 587.
From
This is the email address that will appear as the sender of the email.
It should be a real email address where you can get replies.
Send a test email to the "From" address
Click this button to generate and send a test email to the address
you entered above.
Email Message
This will be the text in the body of the emails you send.
Distribution Email Addresses
You can add a standard list of email addresses. When you set up a meet, you can add more.
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Seasons
Setup » Seasons
ScoreKeeper uses seasons corresponding to a school year which typically start in September. Thus, there are two
years, a starting year and ending year. When you add or edit a season, you will get the simple Season entry form.

Start Year
End Year
When you add a new season, ScoreKeeper will fill these for you so you should seldom need to change them. If you do, you can use the spin
buttons to scroll the year up or down.

Judges

Setup » Judges

While judges are discussed in this chapter on setting up ScoreKeeper, you don’t need to
enter your judges list ahead of entering a meet. It will, however, save valuable time later
on when that time may be better spent doing other tasks.
ScoreKeeper keeps a master list of judges and you pick judges from this list when you
select judges as part of entering a meet. You can also add judges at that time if
necessary.
By default, the master list of judges will display only those judges marked as active.
When you check the Show Inactives check box, the inactive judges will be shown in a
light gray color. You can quickly jump to a judge by typing the first couple of letters of
their last name.
When you add or change a judge record the Judge entry form will be displayed.
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First Name
Last Name
The first and last names are required. When entering data, it can be faster to type a first and last name at
one time. ScoreKeeper helps by checking the first name field for two names and splitting them into their
own fields. This happens when you Tab off the first name field. You can also make it happen by pressing
the F2 key or right clicking in the last name field. If the last name field already has something entered, the
split will not take place.
Rating
This is the judge’s national rating. Use the drop-list to select a rating or press the green dot button to the right to add a rating not already on the
list.
Active
To make a judge inactive, remove the check. This is especially useful if you have judges entered from away meets and you don’t want to show
them on your active list.

Judge Ratings
Setup » Judge Ratings
This is your list of ratings that can be assigned to judges. You can add more ratings if the ones you need are not
already present.

Events

Setup » Events
This list shows the available events for both men’s and women’s
gymnastics. These lists are pre-defined and only some features of
each event can be modified.
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Event Name
This is the full name of the event and it cannot be changed.
Short Name
Enter the short name of the event. This is used to identify the event when space is limited such
as for scoreboards, some screens, web pages, and reports.
Abbreviation
When space is very limited, as in some scoreboard layouts, this two-character abbreviation will
be used to identify the event.
Active
If you do not use this event, you can make it inactive by removing the check mark.
Use vault numbers when entering scores
Check this box if you want the user to enter vault numbers when entering scores. If not
checked, that field will not be available on the score entry screen.
Event can use line judges
Check this box if this event can include line judges. This will allow ScoreKeeper to print line
judge score slips for this event.
Judge Score Slips Paper Color
If you want to customize the paper color requested for this event, select a display color and enter the color name in the text box. When the score
slips are printed, ScoreKeeper will pause and let the user change paper to the selected color before continuing.
If you are using a color printer, the score slips report also gives you the option of printing on white paper but with the event name printed using
your selected color as the name background.
Scoreboard Address
If you are using ScoreKeeper Flasher digital display scoreboards, each board has programmed into it an address. ScoreKeeper sends scores to
different boards based on their scoreboard address. Enter here the address of the scoreboard you will be using to display scores for this event.
NOTE: If you enter an address of 0 (zero), the event will be displayed on all
ScoreKeeper Flasher display boards connected to the computer.
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Vaults
Setup » Vaults
If you want to track the specific vaults performed by your gymnasts, the vaults list is
the place to start. ScoreKeeper has two lists, one for men’s vaults and one for
women’s vaults.
This list has two tabs that select the display order to either vault number order or
vault name order. The radio button option on the right selects which list you want to
view.

Meet Templates

Setup » Meet Templates

Meet templates allow you to save often or seldom used meet settings and recall
them when setting up a new meet. Whenever you add a meet, the first thing you
are asked after picking your home team is to select a meet template. The settings
from the template are then used to fill the matching settings in the meet.
One thing to notice on this screen is the Show Inactives check box near the upper
right corner of the screen. You can make a template inactive without removing it
from the list. Some of the built-in templates are permanent and cannot be
deleted. If you don’t use them the only way to not have them listed normally is to
make them inactive.
From this list you can add, change, or delete meet templates. When you add or
change a template, you are taken to a screen with several tabs. The templates that
are pre-installed in ScoreKeeper are “System” templates and cannot be deleted.
Some of the system template settings also cannot be changed and, although
visible disabled on the screen, will be disabled and not modifiable.
It is likely that you will never need to add a meet template. The system templates
can probably handle every kind of meet you are likely to encounter, especially if
you customize them with your own preferences.
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General Tab
The settings on the General tab reflect the overall type and structure of a meet. This is also where you would make unused templates inactive.
Name
This is the name of the template displayed on lists. It should be
descriptive of the kind of meets for which it is used. In the
above sample screen, this field is gray indicating that this is a
system template. System templates are those that are provided
with ScoreKeeper and some values cannot be changed. You can
add your own templates and change anything.
Meet Type
Indicate here whether this is a team or individual meet. Team
meets can contain individuals but individual meets cannot have
competing teams.
Competitor Type
Select whether this template is for men’s or women’s meets.
Allow individual all-arounders and/or event specialists from
non-competing teams
This is mostly self-explanatory. When checked, you indicate that
there will be gymnasts in the meet who are competing
individually and not with their team. Checking this box also
enables the Individual performance type for gymnasts.
When you select an individual meet type above, this box is
checked and disabled so that it cannot be unchecked.
Allow all-arounder scores that don’t contribute toward the team scores
When you check this box, you enable a special performance type of All-Arounder. This is used in men’s gymnastics where a gymnast is allowed to
compete and have his scores count toward his personal all-around score but not toward the team score on the event.
Allow exhibition performances where scores may be entered but do not count
When this box is checked, it will enable the Exhibition performance type. Exhibition performances are allowed in women’s meets. Gymnasts with
this performance type are scored normally but the scores are not official and do not count toward all-around scores, team event scores, or event
winners. Exhibitions are used to give the gymnast the experience of performing in a real meet.
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Sessions: Number of Sessions
Almost all meets have but one session. The exception is the national championship semi-finals where there are more teams than are easily
handled in a single session.
Sessions: Teams are ranked separately for each session
If there are multiple sessions, indicate by checking this box whether teams in one session are placed separately from teams in the other session.
This also affects gymnast rankings on events.
Numbering
By selecting Manual, you tell ScoreKeeper that the competitor numbers have been pre-assigned. If you select Automatic, you are allowing
ScoreKeeper to number gymnasts automatically.
Calculations: Calculate team totals
If you are entering a team meet, this box should be checked in order to let ScoreKeeper total the team event and final totals. For individual meets,
this box is unchecked and disabled.
Calculations: Calculate event winners
Check this box if there will be winners with place numbers (1st place, etc.) on individual events and, perhaps, all-around.
Calculations: Calculate all-around scores
If you want ScoreKeeper to calculate all-around for gymnasts who compete in all events, check this box. Otherwise leave it unchecked.
Active template
When this box is checked, the template is available for selection when adding a meet.
Secondary Meet Template
This selection is used only for the first meet of a two-meet series. In series meets, the scores of the first meet are carried over and added to the
scores of a second meet. The second meet is an Individual meet, not a team meet. Should you inadvertently select a meet here and this is NOT
the first meet of a series, you can click the button to clear the secondary template.
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Judging & Scoring Tab
There are several variables that are used to set up ScoreKeeper for entering judges’ scores and calculating the resulting scores. They are contained
on this tab screen and the corresponding tab in the meet entry form.
Judges per Event
Enter the number of judges who will be contributing scores
toward the final average. Ignore any judges who will not be
assigning scores or judges whose scores are for comparison
only.
Score Calculation: High Scores to Discard
Score Calculation: Low Scores to Discard
When calculating a gymnast's final score, enter here the
number of judges' scores to discard when they are high or low
scores respectively. For example, when there are four judges
and you want to average the middle two, enter 1 for the high
scores to discard and 1 for the low scores to discard.
Scoring: Score Increment
Enter the smallest score increment judge's scores can use. For
example if a judge can assign scores of 9.7 and 9.75 and nothing
in between, enter an increment of 0.05.
Scoring: Maximum Variation
Enter here a maximum difference between the scores of any
two judges for a single performance. If any two scores differ by
more than this amount, ScoreKeeper will display a warning.
Start Values
Indicate whether you want to enter no start values, one start value, or one start value per judge. Selecting "FIG – One start score per
performance" enables FIG scoring which uses one start value score is reported as the D score on men's score sheet reports.
Team Scoring: Competitors per Event
This is the maximum number of gymnasts who will be counted toward the team score on an event.
Team Scoring: Scores to Count
Enter the number of scores that contribute toward the team score after any low scores are dropped. For example, you may have six gymnasts
competing on an event but only count five scores toward the team score.
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Skip place numbers for tie scores
When calculating winning place numbers, this setting determines how to handle numbers after there is a tie. For example if you have a two-way
tie for second place, is the next gymnast third place or fourth? If you want to skip third place and assign the next score fourth place in this
example, check this box.
Events Tab
The Events tab contains two lists and the buttons to manage
them. The list on the left shows all events that have been
selected for meets based on this template. The list on the right
contains all of the events available for either men's or women's
competitions. If all possible events have been assigned to the
template, this list will be empty.
To assign an event to the template, you can highlight it and press
the button with the double arrows pointing to the left or you can
drag the event from the All Events list and drop it onto the
Selected Events list. To remove an event from the template, you
do the reverse, either highlight it and press the button with the
double arrows pointing to the right or drag the event from the
Selected Events list to the All Events list.
When you add an event to the template, the Score Calculation
screen pops up asking whether this event is a single performance,
the average of two, or the higher of two. Sometimes vaults are
the average or higher of two. Other events are almost always a
single event. The delta button allows you to change the score
calculation type for the highlighted event on the Selected Events
list.
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Output Tab
This tab has a couple of options for outputting information from ScoreKeeper.
Official Score Sheet Reports: Primary and Secondary
Use the drop-list to select the reports corresponding to the
official results form for meets of this type. Either one or two
reports can be selected. The secondary score sheet is not often
used but is required for meets such as the NCAA Regional
Championships.
Official Score Sheet Report: Print gymnast numbers on the
official score sheet
Check this box to include the gymnast’s competition numbers
on the score sheet. Often the number is unnecessary and
printing it reduces the space available for the gymnast’s name.
Display Scoreboard
Use the drop-list to select the type of display scoreboard to use
for showing live scores and final results. This selects a
scoreboard definition to use with meets of this type.
Scoreboard definitions are described in detail beginning on page 72.
Currently ScoreKeeper can output scores directly to boards made by Daktronics and White Way Sign Company. Scoreboards from Elite
Technologies also work with ScoreKeeper but do not use ScoreKeeper’s scoreboard definitions to do so.
If you are using an Elite Technologies scoreboard or any others that do not use the serial data feed from ScoreKeeper, use the small button shown
at the left to clear the scoreboard definition.
Score Display: Rounding Decimals
ScoreKeeper calculates and stores final average scores to five decimal places. Ordinarily, only three places are necessary to differentiate the
closest possible differences between non-tied scores. Enter the number of places you want ScoreKeeper to print on reports and display on the
screen.
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Instructions Tab
On the instructions tab, you can enter special instructions for the user when this template is used to create a meet. This is a mini word processor
allowing you to select fonts, colors, alignment, and other attributes to make the instructions understandable and attractive. The various text and
paragraph attributes can be found on the tool bar that becomes available when this tab is selected.
Each button of the tool bar has a drop-tip that will show you its function when you hold the mouse pointer over the button for a second or so.

Most if not all of these buttons should be familiar to users of most word processing programs such as Microsoft Word.
You can even open and save your instructions as RTF documents, a format that can be used by many word processors and editors such as
Windows Word Pad.

Scoreboards
Scoreboard » Scoreboard Definitions
The topic of scoreboards does not fit neatly in either the program setup or meet setup though it is important to consider when doing both.
Scoreboards are covered detail in starting on page 56 but are mentioned here because there are some important things you should consider early
on.
IMPORTANT: Don’t discount the amount of time that will be needed to set up and test your scoreboard designs.
Depending on the experience of the user, the availability of the user, the complexity of the screens, and
the number of different screens it could take several days to a couple of weeks to get this done and tested.

IMPORTANT: Another thing to consider is that ScoreKeeper can output two different data structures, one for the live
meet data and another for the meet final results. Scoreboard screens designed for live data will display
garbage if you try to use them to send final results. Final results screens need to be designed specifically
for this purpose if you intend to use them.
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Set Screen Font
Setup » Set Screen Font
Sometimes the ScoreKeeper screens are too small to read easily on larger
monitors so you can select a larger font size. The default font and size is
Tahoma, 10 pt. Regular.
While you choose any font or size, we recommend that you stay with
Tahoma because our screens are laid out based on that font so they will look
best using that font.

Clear Screen Font
Setup » Clear Screen Font
If you completely mess up you font selection and want to go back to the
default 10 pt Tahoma Regular (i.e. neither bold nor italic) font, click this
menu option and everything will go back to normal.
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3. Setting Up A Meet
Many activities are involved in preparation for a gymnastics meet. Some of them involve ScoreKeeper directly and some only indirectly. From the
standpoint of the ScoreKeeper user, this chapter will present these activities in the most common order of execution.

Adding a Meet
File » Meets
Once you’ve done the initial ScoreKeeper setup (see page 4 if you haven’t done this yet) everything starts with entering a new meet. From either
the menus or the tool bar, open the meets list.
If this is the first meet you enter in ScoreKeeper or the first for the selected
season, this list will be blank. At the top of the list is the selected home
team. This is here because ScoreKeeper allows for multiple home teams.
Since most schools have only one, there will probably be only one selection.
Next is the season. You can select a season from the drop-list or add one via
the green dot button to the right of the drop-list. You don’t need to select
the season here for a new meet; that, along with much else, is done in the
New Meet Wizard.
If you have meets listed, as in the example screen above, one will have a
green check mark indicating that it is the “Active” meet. The active meet is
the one all other meet related tasks refer to. That makes it easy to print
reports for an earlier meet by highlighting it and clicking the Set Active
Meet button.
To begin the New Meet Wizard, press the Insert key, click on the
button, or right
click the list and select Insert from the popup menu. The wizard guides you through
the process of entering the meet using the Next and Back buttons to move through
the screens. After a short instruction screen the next screen is where you select your
home team.
Use the drop-list to select your home team. Most often, there will be only one
selection. You must select a home team even if that home team is not actually
competing in the meet. This can happen, for example, if your team is hosting a
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championship for which it did not qualify.
If the selected template is for the first meet of a two-meet series, two meets will be added, not one. More information about series meets can be
found on page 34 below.
On the next screen you select both the meet template and season. Meet templates are
a way to store most of the meet settings for different types of meets. ScoreKeeper
comes with several meet templates and you can add more of your own if you wish.
See page 22 for more detailed information on meet templates. Even though this
wizard will take you through several screens, there are many more meet settings that
are filled from the values in the selected template.
After selecting the most appropriate template, select the season in which the meet
will occur or press the green dot button to add a new season to the list.
On the next screen you indicate whether your home team is competing as a team, only
certain individuals are competing individually, or neither the home team nor any team
members are competing. As mentioned above, this situation can arise if your team hosts a championship for which it did not qualify as a team but
perhaps certain team members did qualify as event specialists or all-arounders.
In the example screen above, the Individuals only selection is not available. That is
because a setting in the meet template indicated that this meet does not contain
individual competitors.
On the next screen, shown above, you can enter a name for the meet and enter the
meet date. For the meet name, it is useful to enter a descriptive name such as “OSU vs.
Utah” instead of just listing the visiting team. This is because the meet name is printed
on meet results reports, many of which are given to the visiting team(s) or to another
organization such as the NCAA.
You can enter the meet date directly, use the up and down arrow buttons to scroll to
later or earlier dates respectively, or press F2 or click the Right Mouse button to select
a date from a popup calendar.
The next screen will only be shown if special instructions have been entered in the
meet template. Otherwise the instruction screen is skipped. You can use the template
instructions to communicate any special information or cautions to the user who
enters the meet.

Setting Up A Meet

Page 31

The example screen shown below shows the instructions from the template titled “Women's Collegiate National Championship Semi-Finals.”
On the next screen, you indicate whether this is a home meet or an away meet. This
designation is from your home team’s point of view. This is also where you enter the
meet location that prints on official score sheets.
The next screen has a
check box where you tell
ScoreKeeper that this is an
official meet and that
scores entered during this
meet will be counted
toward a gymnast’s career
total points and both the
team’s and individual’s
regional qualifying scores.
An example of a meet that
are not official would be a demonstration meet or team intra-squad meet given at the
start of the season for your fans.
The other two options determine whether you will be notified when your team or a team
member sets or ties a team or personal record. Check the first of these to include
indicators and a legend on individual event and all-around reports that will show ties and
record scores. The second, if checked, will cause ScoreKeeper to issue an alert to the
data entry person when the tie or record score is entered. This can be disruptive in busy
meets if you are likely to set records or if your home team records have not been
entered previously.
NOTE:

The record scores displayed or printed will be accurate only
if the meet computer has the home team's current record
scores as of the start of the meet.

The subject of the next screen is gymnast numbering. You can use pre-assigned
competition numbers you must enter or arbitrary numbers that ScoreKeeper will assign.
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If you are letting ScoreKeeper assign the numbers, you can tell the program to use the previously entered home team competition numbers. If
using pre-assigned numbers, this selection will not be available and home team numbers will not be used.
The last screen on which there are selections is where you indicate whether you want
to send scores to a serial interface display scoreboard. If your program preferences are
set to not send to a scoreboard or to send via one of the other interfaces, you will not
see this screen.
The final screen is only an information screen reminding you of what remains to be
done in setting up the meet.
Press the Finish button to complete the process of adding the meet record.
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Two-Meet Series
A two-meet series is a set of two meets where the first meet is usually a team meet and the second is
an individual meet. Scores from the first meet determine which gymnasts qualify to be part of the
second meet and those scores are carried over and added to the scores from the second meet. In
order for ScoreKeeper to know when you are working with a series is to form a link between the two
meets and between specific gymnasts in those meets.
The way it does this is by using a linked pair of meet templates that have been set up for this purpose.
ScoreKeeper comes with such a pair of templates: "Women's Team Championships, Day 1 of 2 (Teams
and Individuals)" and "Women's Team Championships, Day 2 of 2 (Individual Finals)." When you create
a meet using the first of these, ScoreKeeper will actually create both meets at the same time and will
link them together.
Add teams and individuals to the first meet as usual. When that meet is finished and you select the
second meet, ScoreKeeper will present the following screen.
When you complete this screen and press the green check button, ScoreKeeper will use the results of
the first meet to fill the second meet with gymnasts and their team information. A single virtual team
will be created containing all selected gymnasts as individual competitors. Each of the gymnasts in the
second meet will be properly linked to their record from the first meet.
WARNING:
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Editing Meets
Once the meet has been added, it is a good idea to check the rest of the options in the meet entry screen.
General Tab
Date
You can enter the meet date directly, use the up and down arrow
buttons to scroll to later or earlier dates respectively, or press F2
or click the Right Mouse button to select a data from a popup
calendar.
Attendance
When you know the meet attendance, enter it here. It is printed
on official score sheet reports.
Meet Name
For the meet name, it is useful to enter a descriptive name such
as “OSU vs. Utah” instead of just listing the visiting team. This is
because the meet name is printed on meet results reports, many
of which are given to the visiting team(s) or to another
organization such as the NCAA.
Location
Enter a meet location. It will be printed on official score sheets.
Home/Away
Using the drop-list, select whether this is a home meet or an away meet.
Opponent
This field is a required entry on the Regional Qualifying Score Sheet report. If you don't enter it here, you will be asked to enter it when you print
the report.
Meet Type
Using the drop-list, select whether this is a team or individual meet. Team meets may contain individuals but individual meets cannot have
competing teams.
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Meet is official and scores count
Check this box to tell ScoreKeeper that this is an official meet and that scores entered during this meet will be counted toward a gymnast’s career
total points and both the team’s and individual’s regional qualifying scores. An example of a meet that are not official would be a demonstration
meet or team intra-squad meet given at the start of the season for your fans.
Different meets allow different types of performances. These check boxes are where you tell ScoreKeeper the performance types allowed in this
meet.
Allow individual all-arounders and/or event specialists from non-competing teams
Check this box to allow entering individual all-arounders and/or event specialists from non-competing teams.
Allow all-arounder scores that don’t contribute toward the team scores
Check this box to allow all-arounders. This is a special performance type where a team member may compete for a score on their personal allaround total but the score in the event in question may not contribute toward the team total.
Allow exhibition performances where scores may be entered but do not count
Check this box to allow exhibition performances. These are scored as if the gymnast was competing on the event but the score does not count in
any way. This is used to give gymnasts experience in a competitive setting when they may not be quite ready to be on the team lineup.
Number of sessions
Some meets have so many teams that the meet is broken into two sessions. If this is the case for this meet, select 2, otherwise select 1.
Rank teams separately for each session
For multi-session meets only, this check box tells ScoreKeeper that each session will be treated separately when determining winning scores.
Numbering
Choose Manual when the competitors use pre-assigned numbers or when you want to number gymnasts yourself. Choose Automatic when want
ScoreKeeper to assign the numbers.
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Scoring & Calculations Tab
Calculate team totals
Check this box if you want ScoreKeeper to calculate team event
and overall total scores. You might want to leave it unchecked for
demonstration or intra-squad meets and, of course, for Individual
meets where there are no teams competing.
Calculate event winners
Check this box if there will be winners with place numbers (1st
place, etc.) on individual events and, perhaps, all-around.
Calculate all-around scores
If you want ScoreKeeper to calculate all-around for gymnasts who
compete in all events, check this box. Otherwise leave it
unchecked.
Competitors
This is the maximum number of gymnasts who will be counted
toward the team score on an event.
Scores to Count
Enter the number of scores that contribute toward the team score after any low scores are dropped. For example, you may have six gymnasts
competing on an event but only count five scores toward the team score.
Start Values
Indicate whether you want to enter no start values, one start value, or one start value per judge. Selecting "FIG – One start score per
performance" enables FIG scoring which uses one start value score is reported as the D score on men's score sheet reports.
Skip place numbers for tie scores.
When calculating winning place numbers, this setting determines how to handle numbers after there is a tie. For example if you have a two-way
tie for second place, is the next gymnast third place or fourth? If you want to skip third place and assign the next score fourth place in this
example, check this box.
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Events Tab
The Events tab contains a list of events and the buttons to manage and order them. The list is populated from the events set up on the template
used to create the meet. The tall buttons with the green arrows move events up or down to place them in the normal event order.
When you add an event to the template, the Score Calculation
screen pops up asking whether this event is a single performance,
the average of two, or the higher of two. Sometimes vaults are the
average or higher of two. Other events are almost always a single
event. The delta button allows you to change the score calculation
type for the highlighted event on the Selected Events list.
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Judges & Judging Tab
Judges per Event
Enter the number of judges who will be contributing scores
toward the final average. Ignore any judges who will not be
assigning scores or judges whose scores are for comparison only.
High Scores to Discard
Low Scores to Discard
When calculating a gymnast's final score, enter here the number
of judges' scores to discard when they are high or low scores
respectively. For example, when there are four judges and you
want to average the middle two, enter 1 for the high scores to
discard and 1 for the low scores to discard.
Score Increment
Enter the smallest score increment judge's scores can use. For
example if a judge can assign scores of 9.7 and 9.75 and nothing in
between, enter an increment of 0.05.
Maximum Variation
Enter here a maximum difference between the scores of any two
judges for a single performance. If any two scores differ by more
than this amount, ScoreKeeper will display a warning.
Enter starting value for each judge’s score
Check this box if you want to record each judge's start value as well as their score.
Event
Use this drop-list to select the event for which you are entering judges.
Judge List
This list shows the judges entered for the event selected above. Judges are selected from the
master Judge list. When you add a judge to a meet, the master judge list screen is opened
where you can select an existing judge or add a new one to the list.
HINT: To assist in this task, print the Judge Information report (Report » Setup for Meet » Judge Information). When no judge information
has been entered, the report will be blank with places available for someone to write the judge names and ratings.
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Output Tab
Primary Score Sheet Report
Secondary Score Sheet Report
Use the drop-list to select the reports corresponding to the official
results form for meets of this type. Either one or two reports can
be selected. The secondary score sheet is not often used but is
required for meets such as the NCAA Regional Championships.
Print gymnast numbers on the official score sheets
Check this box to include the gymnast’s competition numbers on
the score sheet. Often the number is unnecessary and printing it
reduces the space available for the gymnast’s name.
Display Scoreboard to Control
Use the drop-list to select the type of display scoreboard to use
for showing live scores and final results. This selects a scoreboard
definition to use with meets of this type. Scoreboard definitions
are described in detail beginning on page 72.
Currently ScoreKeeper can output scores directly to boards made
by Daktronics and White Way Sign Company. Scoreboards from
Elite Technologies also work with ScoreKeeper but do not use
ScoreKeeper’s scoreboard definitions to do so.
If you are using an Elite Technologies scoreboard, use the small button shown at the left to clear the scoreboard definition.
Name Order
Select here how you want gymnast names displayed and printed on reports.
Rounding Decimals
ScoreKeeper calculates and stores final average scores to five decimal places. Ordinarily, only three places are necessary to differentiate the
closest possible differences between non-tied scores. Enter the number of places you want ScoreKeeper to print on reports and display on the
screen.
Show home team records on reports
Show home team records on screen
Check the box to include an indicator on individual event and all-around reports when your team or a team member sets or ties a team or
personal record. Indicators and a legend will be added to these reports that will show ties and record scores.
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Entering Teams
File » Teams
The process of entering teams is different for team meets and meets which contain only individual competitors and no competing teams. Because
they are far more common, team meets will be discussed first.
Team Meets
When you select Teams from the menu or tool bar, the teams list screen will be
opened.
This screen lists the teams and their team scores. Obviously, when you are first
entering teams, there will be no scores. ScoreKeeper is not an oracle with the
ability to predict the future.
The Name Order and Score Order tabs let you set the display sort order by either
the team name or the team total score. The Non-Competing Teams tab will only
be present on team meets that include individual competitors. When selected,
you will see a list of the teams which have individuals competing in the meet.
These teams will not have team scores since they are not competing as a team.
There are two ways to add a team to the meet. The first is to click the
button (or press the Insert key or right click the list and select Insert from
the menu). The other way is to copy a team, including their gymnasts (but not the event lineups) from another meet. Press the
button (or
choose the copy option from the Right-Click popup menu) and you will be presented with a tree list of meets and teams.
Check the "Automatically show new scores" box in the lower left to automatically update
the team totals when new scores have been entered.
This list works like Windows Explorer in that you click the to the left of a meet to expand
that meet and see the visiting teams. With a team highlighted, press the
button to
select the team to copy. You can then enter the lineup for the copied team.
Whether you added a new team or copied one from another meet, you will then use the
Team entry screen.
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Team Name
Enter the team name as you want it
to appear on screen and on reports.
Short Name
This is a short version of the team
name used on scoreboard displays
and some screens and reports where
space is limited.
Head Coach
Enter the head coach’s name. It will
be printed on official score sheet
reports.
This is the meet home team (NOT
your home team on away meets)
This check box is used to identify the
meet home team. On away meets,
this cannot be your home team.
Gymnasts compete as a team and the
team is scored
This box determines whether
ScoreKeeper will calculate team
scores for this team. Check the box if
the team is really a team even if
there are some individuals listed along with the actual team members. If this is a "virtual team" in which only individual competitors are listed,
leave the box unchecked.
Virtual teams are used in championship meets where a group of individual competitors will rotate as a group rather than being included as extra
competitors on actual teams. Virtual teams can be entered into the rotation order just like regular teams.
Qualifying Score
If the team has a national, regional, or conference qualifying score, you can enter it here. This score is printed on the NCAA Regional Results
Reporting Form official score sheet. Otherwise it appears only on this screen for your information.
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Seed
If the team has been assigned a seed (ranking), you can enter it here. It appears only on this screen for your information.
Competitors
Scores to Count
Occasionally teams from different divisions are in the same meet and the division requirements for scoring dictate that a different number of
scores are counted toward the team score. The default values for these fields are entered in the meet. When different values are entered for a
particular team, the team’s settings will be used for reporting on official score sheet reports. Competitors is the number of gymnasts actually
competing on each event and eligible to be included in the team score. Scores to Count indicates how many scores to total for the team score.
Session
In multi-session meets, select the session in which the team is competing. In single-session meets, only Session 1 is available.
Gymnasts List
This is a list of all of the team’s gymnasts, or at least all who are attending and are able to compete. It is a really good idea to take the extra couple
of minutes to add all of these gymnasts to the list and not only those in the submitted lineup. This will save valuable time later on if a lineup
change occurs during the meet and you had the foresight to add the new gymnast to the list.
When you add a gymnast to the list, one of three things will happen. If this is a team meet that does not include individuals, the gymnast entry
screen will be opened immediately. If it is a team meet with individuals, a popup menu lets you select adding a team member or an individual. If
this is an individuals-only meet or you selected to add an individual to a team meet, you will be presented with a list of non-competing teams
from which to select. If the gymnast you are entering belongs to one of the teams on the list, select it. Otherwise you can add a non-competing
team to the list before selecting it.
This gymnast entry screen is fairly selfexplanatory. In ScoreKeeper, all gymnasts must
be assigned a number but it is not necessary
that you enter the number here if ScoreKeeper
will be assigning the numbers later. If the meet
uses pre-assigned numbers, the number field
will be required and tinted the same color as
the name fields.
If you return to the gymnast entry screen after
lineups have been entered, the screen looks quite different. The events on which the
gymnast is in the lineup will be displayed in the list along with their scores (if any)
and indicators of whether the score set or tied a personal or home team record
score (for home team gymnasts only).
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On the gymnast’s list, team members are shown in a different color than individuals. The specific colors used are selectable in the Program
Preferences (Setup » Program Preferences).
Lineup Event
Select an event from the drop-list to view or change the lineup for that event.
Lineup List
This list shows the gymnasts in lineup order for the selected event. There are a couple of ways to add gymnasts to the lineup. The easiest and
fastest is to drag a competitor from the gymnast list to the lineup list. The other way is to highlight the competitor in the gymnast list and click on
the
button. To remove a competitor from the lineup, drag them back to the gymnast list or click on the
button. The tall buttons with
green up and down arrows will move the highlighted competitor up or down in the lineup.
As in the gymnast list, competitors in the lineup will be shown with a color associated with the competition type (team competitor, all-arounder,
individual, or exhibition) and these colors may be chosen in the Program Preferences.
Change Performance Type button
When adding competitors to or moving competitors up or down in the lineup, ScoreKeeper will attempt to set the correct performance type.
However, sometimes it is unable to read your mind and you will have to set the performance type yourself. That is what this button is for. It sets
the performance type for the highlighted competitor.
Internet Settings
Clicking the Internet Settings button in the
upper right part of the team screen opens a
window where you can set the team's home
page settings. For your own team, this is filled
automatically if you have entered the
information on your Home Team record.
Team Home Page
If you know the team's home page on the web,
entering it here will create a link from your
meet results web page to the team's home page.
Meet ID
This is the Meet ID assigned by the Troester system to this meet. Unfortunately, there is not a single Meet ID assigned to a meet by the system,
there is actually one for each team in the meet. In this field, use the Meet ID associated with the team you are updating.
Team ID
Enter here the Team ID assigned to this team by the Troester system.
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Individual Meets
For Individual meets, there is only one
competing “team” and when you select
teams from the menu or the tool bar, the
lineup screen for Individual Competitors is
opened.
For the most part, this screen works just like
the team entry screen for adding gymnasts
and adding them to the lineups for each
event.
Gymnasts List
This is a list of all of the competing
gymnasts. When you add a gymnast to the
list, you will be presented with a list of
non-competing teams from which to
select. If the gymnast you are entering
belongs to one of the teams on the list,
select it. Otherwise you can add a noncompeting team to the list before selecting it.
The gymnast entry screen is fairly self-explanatory.
In ScoreKeeper, all gymnasts must be assigned a
number but it is not necessary that you enter the
number here if ScoreKeeper will be assigning the
numbers later. If the meet uses pre-assigned
numbers, the number field will be required and
tinted the same color as the name fields.
If you return to the gymnast entry screen after
lineups have been entered, the screen may look
quite different. The events on which the gymnast
is in the lineup will be displayed in the list along with their scores (if any) and
indicators of whether the score set or tied a personal or home team record score
(for home team gymnasts only).
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Lineup Event
Select an event from the drop-list to view or change the lineup for that event.
Lineup List
This list shows the gymnasts in lineup order for the selected event. There are a couple of ways to add gymnasts to the lineup. The easiest and
fastest is to drag a competitor from the gymnast list to the lineup list. The other way is to highlight the competitor in the gymnast list and click on
the
button. To remove a competitor from the lineup, drag them back to the gymnast list or click on the
button. The tall buttons with green
up and down arrows will move the highlighted competitor up or down in the lineup.

Assign Rotation Order
File » Rotation Order

ScoreKeeper needs to know which teams are on which events for each rotation and this is how you enter that information.
For each rotation and each
session, you can select which team
is on each event. First set the
session and rotation in the upper
left corner of the screen. Then you
can add teams from the Team Pool
list to the event list in either of two
ways. You can highlight the event
and team and press the
button
to assign the team to the event or
you can drag a team from the
Team Pool and drop it on an event.
Teams that have been assigned to
an event for the selected rotation
are displayed with a shaded
background. This makes it easier to
see which teams have not yet been
assigned.
If there should be no team on an event in a rotation, you can assign the No Team “team” to the event. This team will be colored with red text on a
yellow background.
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Number Gymnasts
File » Number Gymnasts
If you are letting ScoreKeeper assign gymnast numbers, you have some options
on how numbering is performed.
Format
By choosing Block of numbers for each team, ScoreKeeper will number each
team separately in a block with a set number of competition numbers
reserved for each block.
Block Size
When numbering teams in a block, this sets the number of competition numbers reserved for each block. If there are more gymnasts on a team
than numbers in a block, the block size for that team will be progressively increased by 10 until all of the team’s gymnasts are numbered.
For example, with a block size of 20, the first team would start at 100 and go through 115 if they have 16 gymnasts. The second team would start
at 120 and so on.
Start At
This is the number with which numbering will start. In other words, the first gymnast numbered will be assigned this number.
Individuals
For team meets that include individuals, you can number the individuals with (but after) the team members or number them separately with
other members of their actual team.

Validate Team Lineups
Report » Setup for Meet » Lineup Validation Forms
Once you have entered all of the data, numbered the gymnasts, and assigned rotation order, print the lineup validation forms report. You can print a
form for each team at once or select a single team to print. This form shows coaches the current lineups and gives them a place to make changes.

Backup Your Data

File » Backup Data Files

After you have spent all this time entering data, you don’t want to lose it if the computer dies. Using the menu or tool bar, backup your data files to a
removable medium or a network.
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Using Test Mode
It is often a good idea to test that everything is working correctly, especially if you are using a display scoreboard. Testing usually means entering
some scores and that can mean a laborious process of removing them later. Fortunately, ScoreKeeper comes to the rescue by providing a test mode
you can turn on or off (File » Use Test Mode). When in test mode, the program will not update any of your home team records so you can safely enter
10.0 for all your favorite gymnasts.
When you are finished testing, don’t forget to turn off test mode. When test mode is turned off, the program will ask if you want to delete all the
scores that have been entered.
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4. During A Meet
There are two important functions that happen during a meet: scores are entered and results are output. You can enter scores into ScoreKeeper
directly or through the DDE interface.

Entering Scores Directly
File » Enter Scores
This screen has a lot of information on it but is surprisingly
easy to use. However, a brief description of the screen’s
features and how they are used is in order because some
of the features may not be obvious.
Selecting a Session/Rotation
In the middle right portion of the screen are two large
spin controls where you can select both the session (in
multi-session meets only), and rotation. These selections
affect only the scores entered on this screen. However, if
you choose a later session or rotation, the program will
ask if this is a new rotation and adjust the global session
and rotation values on the tool bar accordingly.
Selecting an Event
The Current Event list in the upper left of the screen
shows all possible events in the meet with the current
event highlighted. To switch to a different event, click on
the event name. As soon as you do this, the team on that
event in the current rotation will be displayed in the
lineup list on the right.
When there are two vaults, both will be listed allowing
you to select either the first or second vault.
Selecting a Gymnast
The list in the upper right part of the screen shows the lineup for the current session, rotation, and event. Gymnasts are listed in lineup order and
color is used to differentiate different performance types: competitor, all-arounder, individual, or exhibition. In the example screen above, the first
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six gymnasts are team members and the seventh is an individual. The first gymnast is selected. The team on which the highlighted gymnast is a
member team is shown in bold above the list. The team name will change when an individual competitor is selected.
When the screen is first opened or when the session, rotation, or event is changed, the highlight will jump to the first gymnast who has not yet
been scored. If all gymnasts have been scored, no gymnast will be highlighted initially.
When a gymnast is selected, the cursor jumps to the first judge score field. If you have enabled entering judge start values in the meet setup, the
cursor goes first to the start value as in the example screen above. In this meet (this is real data from the 2004 national championships), start
values were not entered; this was turned on so that the screen image would show the start value fields. When not enabled, you will not even see
the start value fields.
Changing Lineups
Changing a team's lineup is a fairly simple process. With the current lineup shown, press the
button, the change lineup button. After
confirming that you do want to change the lineup, this fills the lineup display with all gymnasts competing with the selected team and enables the
three buttons immediately below the change lineup button. The big green up and down arrow buttons move the highlighted gymnast up or down
in the lineup.
The green delta button (
) changes the competition status (competitor, exhibition, all-arounder, individual, or not competing) but ScoreKeeper
handles this automatically when you move gymnasts around. If ScoreKeeper guesses wrong, you can change the status with this button.
When you are finished with the lineup changes, press the lineup change button again to save or discard your changes.
Refreshing the Lineup and Scores
Since ScoreKeeper Remote can enter scores and change lineups (if you allow this), you may need to update your display from time to time to
reflect changes made in ScoreKeeper Remote. Press the F5 key to refresh the current team lineup and scores. You can accomplish the same thing
with the mouse by Right-Clicking on the gymnast list.
Entering Scores
Notice that in the example screen above the first start value score is selected and that the field has a red background. This is a strong visual
indicator of which score you are entering. You can type a score if you wish or use the small scroll buttons to increment or decrement the selected
score. However, the easy way is to click on the score in the block of scores in the center of the screen. When you do this, the score will be entered
and the next score field will be selected. This lets you enter scores very quickly and accurately.
When the last judge score has been entered, the next field selected is the Neutral Deduction. This field has its own deduction buttons or you can
enter a deduction by typing it.
As you enter scores and neutral deduction, ScoreKeeper will calculate and display the final score in the box in the lower right corner of the screen.
When there are two vaults, the current vault and final vault scores will both be displayed.
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Deleting Scores
If you need to completely delete a gymnast’s score on an event, select the event and gymnast so that
their judge score are displayed then press the Del or Delete key on you r keyboard. The program will
ask if this is really what you want to do.
Vault Numbers
If you have set your vault events to use vault numbers (Setup » Events, select Vault), the vault number
field will be available. Otherwise it will be hidden. If you know the vault number, you can enter it.
Otherwise you can right click on the field or press F2 to select the vault from a list. You cannot enter an
invalid vault number; the number you enter must be on the list. You can add it to the list if necessary.
Team Neutral Deductions
In the event there is a team neutral deduction, press the Team Neutral Deduction button. This opens the Team Neutral Deduction entry screen.
Non-Event Related Deduction
Even more unlikely than receiving a team neutral deduction is a deduction that is unrelated to the
current event. Still, it is possible. Such a deduction will be subtracted from the team’s final team total
rather than the team total for the current event.
In the rare occurrence where a team gets more than one non-event neutral deduction, you will have
to add them together yourself because ScoreKeeper only stores one value.

Event Neutral Deduction
Each event in the meet has a single possible neutral deduction. When the team deduction is related to the current event, this is where you enter
it. The deduction will be subtracted from the team’s event total score.
In the rare occurrence where a team gets more than one neutral deduction for the event, you will have to add them together yourself because
ScoreKeeper only stores one value for each event.
Judge Names
The Names check box lets you see the names of the judges rather than Judge 1, etc. When entering start values, only the last name of each judge
is displayed. Otherwise, the first and last name will be shown.
Save the Score
Once you have entered the scores, neutral deduction, and vault number (if enabled), click the save button to save the score for the gymnast. When
you do this, many things happen in the background.
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1. ScoreKeeper looks to see if the gymnast has competed on all events and calculates the all-around score if so.
2. The team’s event and overall total scores are calculated. The scores displayed on the team list are updated if that screen is open in the
background.
3. The program checks to see if this is a home team gymnast and compares the new score with personal and team records. If you have enabled
screen alerts and the gymnast has set or tied a personal or team record, an alert screen will be opened.
4. If you are sending results to a display scoreboard via a serial interface, the data is formatted and transmitted. Optionally, the results are also
sent to a data file.
NOTE: You must have enabled all the proper program preference and meet options related to
scoreboards. Also, on the Scoreboard menu, the Enable Live Scoreboard must be checked.
5. If you have enabled web page generation, ScoreKeeper will create the page as a file. If you have also enabled sending the file to your web
server or ISP, ScoreKeeper will connect to the server via an FTP interface and will copy the web page file to the server.
NOTE: You must have enabled all the proper program preference and the Web Pages menu
option Enable Web Page Generation must be checked.
NOTE: The Enable Web Page Upload check box on the Web Pages menu must be checked to
actually upload your web pages.
Finally the scores on the screen are cleared and the next gymnast is selected.
This all takes place quickly and you should have very little wait time before you can enter the next score.
Clearing the Display and Scoreboard
When you click the Clear button, it will clear any scores currently displayed. It will also clear your scoreboard. For Daktronics and White Way
scoreboards, it asks whether you want to clear the scoreboard then, after confirmation, completely clears the entire scoreboard display. For
ScoreKeeper Flasher display boards, it returns the display to the event name without confirmation.
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Entering Scores with ScoreKeeper Remote
An alternative to entering scores via your main computer, you can use a computer running the ScoreKeeper Remote program at each event (one
per event). Score Entry is much like in the main program but for only a single event. The ScoreKeeper Remote program is described in the
ScoreKeeper Remote User Guide.
Normally ScoreKeeper automatically updates your meet web page and your display scoreboard when scores are entered and ScoreKeeper Remote
does not do this. If you want to automatically generate web pages and/or output information to a display scoreboard, use the Timed Output option
on the File menu or the button on the tool bar. This option is discussed below.
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Viewing Results
Team Results
To watch team results change, leave the teams list open and check the "Automatically show new scores" check box in the lower left. This check box
causes ScoreKeeper to update the team scores as new scores are entered.
Individual Event Results
To view live results on a selected event, open the live events screen by selecting the Report »
Display Event Results menu or clicking on the equivalent tool bar button shown above.
On this screen you can select the event to display. If you want the results to update when new
scores are entered, check the "Automatically show new scores" check box.
Note that color is used to make it clear which gymnasts are tied. Each time a place number
changes, the color alternates between a white and light green background.

Verify Scores
ScoreKeeper provides a simple way to verify scores on the screen without having to print a score
sheet. Select the Report » Verify Scores menu or click the Verify Scores button to open the following
window.
On this screen you can see the tabs
along the top, one for each event. Only tabs with a team on the event in the current
rotation are enabled. You can select the rotation at the bottom left of the screen.
The first column to the right of the gymnast names is their final score, carried out to five
decimal places which is how ScoreKeeper stores it. Next is the neutral deduction
followed by each judge's score.
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Timed Output
When scores are entered via DDE or by using ScoreKeeper Remote, the program does not automatically generate your meet results web pages or
send data to a display scoreboard. Both of these happen when you enter score directly in ScoreKeeper. To tell ScoreKeeper to take care of these
functions when not entering scores directly, use the Timed Output function.

You can set the options to update the scoreboard and the web page separately. Scoreboard update is dependent on the session and rotation so you
are given entries where you can select the current session (on multi-session meets) and the current rotation. You can also indicate how often to
update the scoreboard and web page.
If your scoreboard uses an XML file rather than the RS-232 serial port output, remove the check from Update scoreboard.
The update will begin as soon as the screen is opened. The red numbers on the right are a count-down and show the number of seconds before the
scoreboard, XML file, or web page is updated.

ScoreKeeper Viewer
The ScoreKeeper Viewer program is designed to display updated results to television and other media people and on video scoreboards. The
ScoreKeeper Viewer utility program is described in the ScoreKeeper Viewer User Guide.
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5. Reports
ScoreKeeper has a variety of reports for helping to setup and run a meet and to report on the results. There are also statistics reports for your home
team.

Meet Results Reports
Reports » Meet Results
ScoreKeeper has several reports for meet results. This
menu is dynamic and depends on settings in the current
meet for the official score sheets. Where you see “NCAA
Women’s Gymnastics Score Sheet” in the above example,
it can list either one or two reports selected from a list of
the supported official score sheet reports. You can select
both a primary and a secondary score sheet on the
Output tab of the Meet entry screen.
Team Standing
This report lists all teams in order by placing.
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Team Detail
This report lists all teams in placing order and includes detail for each gymnast. If there are individuals they are listed with their actual team at the
end of the report. Since individuals from a particular team may be in both sessions of a multi-session meet, all individuals are reported.

Event Results
For each event in the meet, you can print a results report. The report setup lets you select one or more events to print in one report. When the
meet is the second meet of a two-meet series, you will have the option to print results containing combined scores or results for the current meet
only.
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All-Around
The all-around report comes in two styles. The Preliminary report will include all gymnasts who have competed, whether they have completed all
events or not. The Final report will include only those competitors who have performed in all events.

Official Score Sheet Reports
ScoreKeeper supports a variety of "official" results reports though only rarely is it necessary to use more than one. You can select either one or two
of these reports for each meet on the Output tab of the meet settings.
NCAA Women's Gymnastics Score Sheet
This is the complex report required by the NCAA to report women’s gymnastics meet results.
Generic Women's Gymnastics Score Sheet
This is the same as the NCAA Women's Gymnastics Score Sheet except that it does not refer to the NCAA.
Women's Individual Event Finals Score Sheet
This is the complex report required by the NCAA to report the results of the national championship individual event finals.
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NCAA Men's Gymnastics Score Sheet
This is the complex report required by the NCAA to report men’s gymnastics meet results.
Generic Men's Gymnastics Score Sheet
This is the same as the NCAA Men's Gymnastics Score Sheet except that it does not refer to the NCAA.
NCAA Regional Results Reporting Form
This report is required by the NCAA to submit results of regional championships.
Championship Draw Slips
This report is used in meets that are preliminary to a final championships. It includes slips for qualifying teams for team finals and gymnasts for
individual event finals. The slips are put in a “hat” and drawn to assign rotation and lineup order for the final championships.

Reports

Page 59

Meet Setup Reports
Reports » Setup For Meet
ScoreKeeper includes a number of reports that will help
you run your meet. Over time you will determine which of
these you want to use. Initially try printing all of them so
you have a good idea of how they can be used.

Competitor List
This is a simple paid or lists of gymnasts; one by name and one by competition number. It is usually only one page in length.
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Team Competitors
This is a list of competitors by team along with their competition order and performance type on each event.

Hand Scoring Sheets
This is a series of sheets, one set for each event, listing the teams on that event in rotation order and giving a place to write the individual judge
scores, neutral deduction, and final score.
When this report is used for an individuals-only meet is
formatted to look similar to the Hand Scoring Half
Sheets report below.
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Hand Scoring Half Sheets
This report is printed with two of these forms per page. Thanks to Bobbie Cesarek for this report.

Score Validation Sheets
This report is identical to the Hand Scoring Half Sheets above except that the judge and final scores are filled-in so that you can compare the hand
entered and computer generated versions easily.
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Rotation Sheets
This report shows the teams and lineups for each rotation and includes other team gymnasts not on the lineup. A new page is started for each
rotation.

Rotation Summary
This report attempts to compress all of the rotation and lineup information onto a single sheet. Only gymnasts in the current lineup are printed. In
meets comprised only of individual competitors, you can select breaks between "Flights" or groups of competitors that compete in a block with
their own warm-up period. If flights are specified, this report shows them.

Many thanks to Kirk Barbieri for suggesting this report and providing examples.
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Judge Information
This report does two things. Before you have entered your judges for the meet, this report is a blank form with places for someone to write the
judge names and ratings. It is useful to hand to the meet director when you are setting things up so that it can be returned with judge information.
Once you have entered the judges, this report prints the judge list
and is useful to give to the meet announcer so that he or she has a
readable copy and doesn’t have to decipher a hand written list.

Judge Scoring Slips
This report prints a score slip for each judge, competitor, and event.
There are four per page and you can print each event on a different color
of paper if you wish. You can use the suggested colors or change the
suggestions in Program Preferences (Setup » Program Preferences).
A report option lets you print these slips with a background color in the
Event box as shown in the sample above. Each event is a different color
making it easier to sort the slips appropriately.
Only the slips for the head judges show the Final Average Score box.
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Line Judge Slips
Print this report if you want score slips for floor exercise. You can select the number of slips to print for each performance.

Blank Score Sheets
Use this report to can print completely blank official score sheets. Only the form will be printed with no gymnast lineups. If you want a score sheet
with lineups, print the one from the Meet Results reports.
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Lineup Validation Forms
This report gives you an easy way for coaches to verify that their lineups have been correctly entered and to make changes as necessary. You can
print this report for all teams or for a selected team.

Scoreboard Data Layout
This is the same report that is listed under the Scoreboard menu and described on page 71. It is included on this menu for consistency in having all
reports listed under the Reports menu.
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Home Team Statistics Reports
Reports » Home Team Statistics
Statistics by Gymnast
This report gives coaching and sports information staff
a summary of each home team gymnast's
performance for a season or their whole career at the
school. You have the option to print each gymnast on
a separate page. This is useful to prevent information
for a gymnast to be split across two pages.
Scores with a strikethrough indicate exhibition
performances. Scores in italics set or tied a personal
record and scores in bold set or tied a team record.
Not shown in the above example are the optional sum
of career total points.

Regional Qualifying Score Sheet
The Regional Qualifying Score Sheet report was
modeled after the official 2006 NCAA form for
women's gymnastics. The above sample shows the
top section of the first page. The next section, not
shown shows the away scores in the same format as
the home scores box. The final team and allarounder RQS is shown below.

Reports

Page 67

Subsequent pages of the report show the RQS results for individual events, in this sample, Vault..

Honor Roll
The Honor Roll report was designed to report on the top scores for a group of teams in a conference but can also show the top scores of the season
for a single home team as in the example above.
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Newspaper Results
Reports » Newspaper Results
Technically, this isn't a report in that it does not send anything to the printer. Instead, it puts the meet results into a format you can send to your
local newspaper. You can copy the results to the Windows clipboard and you can save them to a text file. The results can be edited before copying
or saving.
At the top of the screen, you can set several
options that control how the results are
presented. For team and gymnast places, use
zero to show all places.
When you have set the options the way you
want them, click the Generate Results to
Window button. If you don't like what you
see, change the options and regenerate or
edit the results. When you have them the way
you want them, you can highlight everything
by pressing Ctrl+A then copy them to the
Windows Clipboard by pressing Ctrl+C. The
Save Results to Text file does what you expect.
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6. Scoreboard Systems
Scoreboard and Display Interfaces
ScoreKeeper supports four scoreboard interfaces.
1. Serial Data Interface
2. DDE (Dynamic Data Exchange) Interface
3. XML (eXtensible Markup Language) File Interface
4. Video Interface
So far as we know, this lets us support every kind of scoreboard or display system currently available anywhere.

Serial Data Interface
The first scoreboard interface uses your computer’s serial port (this is the 9 or 25 pin RS-232 connector, not the USB which is also a kind of serial
port) to send data to another computer that controls the scoreboard.
Displaying data using the serial interface (used by scoreboards from Daktronics, White Way Sign Company, and the ScoreKeeper Flasher) is
controlled to a large degree by ScoreKeeper. For Daktronics and White Way scoreboards the scoreboard computer (not the one running
ScoreKeeper) sets aside a block of memory and periodically reads the contents of this memory block and displays whatever it finds there.
ScoreKeeper initiates the communication and sends the data to the scoreboard computer which puts it in its memory block for display.
ScoreKeeper Flasher scoreboards work differently than Daktronics and White Way scoreboards. The Flasher boards are small, single line displays.
The content is completely controlled by ScoreKeeper. Either the ScoreKeeper main program or the ScoreKeeper Remote program can control Flasher
boards and you can connect multiple boards in series if you wish. Each board has its own internal address and ScoreKeeper sends data to a specific
address or in broadcast mode to all addresses.
With any serial port scoreboard system, you can instruct ScoreKeeper to send data to a file on your computer when it sends it to the scoreboard.
This can help in solving problems should they arise.
When ScoreKeeper executes the internal command to send data to the scoreboard, it reads the scores and other information about the meet and
compiles it into a formatted data block. This block is transmitted to a receiving computer via a serial port. The settings controlling the port and the
serial communications may be changed in the Program Preferences. Transmitting the data is similar to the way a computer can connect to the
Internet via a telephone line. The difference is that the scoreboard uses a direct connection to the scoreboard computer instead of a modem. When
the data block is received, the scoreboard computer places it in memory for display.
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The specific format of the data block is determined by which scoreboard definition selected and how many teams and/or individuals are competing
in the meet. Once both of these are determined, the structure of the data block does not change for the meet. Naturally, the actual data in the block
does change as scores are entered and totals calculated, but the structure itself doesn’t change. You can print a report that describes the details of
this structure.

Above is a section of a scoreboard data layout report showing data locations and sizes.
ScoreKeeper can send its data either whenever a new score is entered, when Display Live Data is selected from the Scoreboard menu, or both.
You can also generate a definition file (ITF File) that many Daktronics scoreboard systems can use to greatly reduce the amount of time it takes to
design the scoreboard displays.
Scoreboard systems from different manufacturers work differently. However, part of the scoreboard display design process is similar for both
supported systems and starts with knowing where a particular piece of data resides in the data block and how big that piece of data is. For example,
the name of the first gymnast might start at the 26th character and be 20 characters long. Using this bit of information, the user would decide the
font, font size, and where on the scoreboard screen to place it. The scoreboard layout report will gives you the starting location and size of every
piece of data in the block. The Daktronics ITF file generated by ScoreKeeper also has this layout information as well as sample data for each piece of
data making scoreboard screen layout much faster and easier.
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Scoreboard Definitions
Scoreboard » Scoreboard Definitions
Each scoreboard definition defines two layouts, one for live meet data and another for the
final results. Since you can select the scoreboard definition used for a meet, you can use
different layouts for different types of meets.
ScoreKeeper compiles meet information into one large block from a series of smaller fixedsize blocks. Each team is a block containing other fixed-size blocks. Some blocks are
individual data elements, such as a score, others, like the team block, are collections of
other, smaller, collections of blocks as well as individual data elements. The team block
consists of team information elements and one or more event blocks. Each event block
contains an event name, team event score, and a series of gymnast blocks, each containing a
name, score, and optionally a competitor number.
Scoreboard definitions let you determine the presence or absence and size of certain
elements in data blocks. They also determine whether data is sent only for teams in the
current rotation or for all teams in the meet or session. You can also set the definition to
include or exclude individual competitors.
ScoreKeeper comes with several preset scoreboard definitions. You can modify these definitions or add your own to the list. Two of these are
designed to be compatible with the DOS version of ScoreKeeper and should not be modified. Certain aspects of the definition may require some
technical knowledge of nature of the data block expected by your scoreboard.
One thing to notice on this screen is the Show Inactives check box near the upper right corner of the screen. You can make a scoreboard definition
inactive without removing it from the list. Some of the built-in definitions are permanent and cannot be deleted. If you don’t use them, the only
way to not have them listed normally is to make them inactive.
IMPORTANT:

If you have not purchased ScoreKeeper Flasher scoreboards, scoreboard definitions
for this scoreboard will not be shown and you cannot add a definition of this type.

When you add or change a scoreboard definition, you will use the Scoreboard Definition entry form. The form has several tabs of information.
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General Tab
Settings on the General tab determine the kind of meets where the definition
may be used and control the overall structure of the scoreboard data.
Name
This is simply the name you give the definition. Its sole use is to describe the
definition on a list so it can be distinguished from other definitions. In the
above sample screen, the name field is gray indicating that this is a system
record and some settings may not be changed.
Display Type
Select the kind of scoreboard display that will use this definition. This setting
determines how ScoreKeeper generates its display output.
Meet types where available
Indicate here whether the definition can be used for team meets, which may
or may not include individuals competing without their team, and individual
meets where there are no teams competing.
This also determines whether ScoreKeeper will include blocks for competing
teams or solely for individual gymnasts competing on an event.
The Teams to Include and Events to Include selections are used only for team
meets. If you are defining an Individual meet, they will be disabled and not
available.
Active
This is where you make a definition active or inactive. Remove the check to make it inactive. An inactive definition cannot be selected for a meet.
Teams to include
This selection determines how many teams are included in the data sent to the scoreboard. There are three possible choices:
Include only teams in the current rotation. If there are fewer teams than events, this will result in all teams included in the scoreboard data. If
there are more teams than events, this will only send data for those teams in the current rotation.
Include all teams in the current session. For single session meets, which describes most meets, this selection is no different than the following
selection to include all teams in the meet. In multi-session meets such as the national championship semi-finals, this selection allows you to limit
the display to only those teams in the current session.
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Include all teams in the meet. As the selection states, this will include all teams in the meet whether they are competing in the same or another
session.
Events to include
This selection determines which events to include in the scoreboard data. The scoreboard data can include only the current event on which a
team is competing (or on which it last competed) or it can include all events for every team shown. Naturally, the size of the data block sent for
the second selection is much larger than the first.
When you select Current (or last) event, only the most current event data is included for each team displayed. If you are displaying teams not in
the current rotation, data will be displayed for the last event on which they competed.
Display Order
This selection is for Individual meets only, not for team meets, even if they include individual competitors. It determines the order in which the
gymnasts will be presented for each event.
Data Settings Tab
This tab is where you determine how the data is formatted to appear on the
scoreboard display for live scoreboard data. Scoreboard computers select data
elements by their exact position within the overall data set. If you make a
change to the size of a data element, this will change the position of all
succeeding elements. If you are using a Daktronics scoreboard, you will have to
modify the source of the data for each element. The data layout for White Way
scoreboards is preset by White Way programmers so any changes you make to a
definition that works will cause the scoreboard display to appear scrambled.
Team Display: Name Size
A team’s short name can be up to 10 characters in size. This setting tells
ScoreKeeper how many characters of the short team name to send to the
scoreboard. The DOS version of ScoreKeeper used a short name size of four
characters.
Gymnast Display: Name Format
You have five options on how you want to format the gymnast’s name. The
selections are self-explanatory.
Gymnast Display: Name Size
Indicate how many characters to send for the gymnast’s name. The size should be determined in part by the name format selected above. The
DOS version of ScoreKeeper used only the last name and was limited to nine characters.
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Gymnast Display: Number Size
Enter a number from zero to four for the number of characters to reserve for a gymnast’s competitor number. A setting of zero will cause the
number to be omitted. The DOS version of ScoreKeeper used a number size of three characters.
Score Display: Decimals
ScoreKeeper calculates and stores final scores to five decimal places. The default value of three decimal places is all that is needed to differentiate
placing under most circumstances. The number of places also determines the number of characters needed to represent scores. The DOS version
of ScoreKeeper used three decimal places.
Event Display: Event Size
Each event has a short name of up to ten characters in length. Indicate here how many characters to reserve for the event name in the
scoreboard display. The DOS version of ScoreKeeper used five characters.
Number of Gymnasts to Display: Maximum Count
For team meets, this is the number for the number of gymnasts to include for each team. For individual meets this setting is not used.
Number of Gymnasts to Display: Individuals
Team meets may include gymnasts competing individually and not as team though these individuals usually rotate with a competing team.
Individual meets contain only gymnasts competing individually and not as team.
This entry is the number for the number of individual gymnasts to display per event. You may need a larger or smaller number depending on
whether you include both sessions in a multi-session meet.
Show individual judges' scores in addition to a final score
This setting applies only to ScoreKeeper Flasher display types. When checked, the flasher board will show the gymnast's name, each judge's score,
and the final score. When not checked, only the gymnast's name and final score are displayed.
Because the definition shown in the sample screen above is not for a ScoreKeeper Flasher display type, the selection is unavailable on this screen.
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Final Results Tab
This tab determines the scoreboard data layout for the meet’s final results. This
is a completely different and separate layout than the one used to display live
scores during the meet. If you send final results to the scoreboard and have not
switched layouts on the scoreboard system, you will get a whole lot of garbage
displayed on your scoreboard.
Team Results: Maximum Places
This is the highest place number (1 is first place) to include in the scoreboard
display. An entry of 3 means that only fist, second, and third place teams will
be displayed including ties.
Team Results: Include team totals for each event in output
Check this box if you want to include, in addition to the team’s final score, the
team total on each event. Leave it unchecked to only include the team final
score.
Event Results: Maximum Gymnasts
Use this setting to limit the total number of gymnasts that will be displayed on each event.
IMPORTANT:

If you set this too low, it is possible to exclude gymnasts who would be included based on their place number.

Event Results: Maximum Places
Use this setting to limit by place number. An entry of 3 means that only fist, second, and third place gymnasts (including ties ) will be displayed.
All-Around Results: Include All-around as an event in output
Check this box to include all-around winners in the final results. The data layout will be just like an event. The short event name for all-around is
entered in the Program Preferences. See page 8.
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Header and Footer Tab
Scoreboards use specific information at the beginning of the data stream, a
header, to determine where the data block begins. White Way scoreboards also
use a footer to let them know where the data block ends.
In order to be effective, a header and footer must not be anything that could
possibly be included in the actual data. Since the data only includes displayable
characters, headers and footers contain at least one “control” character.
In addition to normal displayable characters, data headers and footers can
contain three special kinds of data.
Control Characters

Control characters are entered by enclosing the
ASCII number for the character in angle brackets, for
example <13>. You can enclose multiple numbers
within one set of brackets by separating the
numbers with a comma, <13,10>. Do not include any
spaces anywhere between the angle brackets.

Incremented Numbers

You can include a number that is incremented with
each transmission. These are the numeric characters
0-9, not ASCII control characters. In ScoreKeeper,
you can do this by enclosing from one to three
number symbols in angle brackets. For example, <#> will be replaced with 0 through 9 then cycle back to 0. <##> will be
replaced with 00 through 99 then cycle back to 00.

Trailing Spaces

Header and footer entries are clipped to remove trailing spaces before being sent to the scoreboard. If your header or
footer must contain one or more spaces at the end, use the underline character. When the header is generated, trailing
underline characters are converted to spaces.
An underline character anywhere other than at the end of the header will be send as the underline character. If you
need use an underline character at the end of your header or footer, enter it as if it was a control character: <95>.

Live Scores: Header
Daktronics scoreboards use the eight character header shown in the screen picture above. It begins with the carriage return character, ASCII 13.
This is followed by a single character incremented number, four fixed characters, and two trailing spaces.
White Way scoreboards use a six character header starting with the Start of Transmission control character, ASCII 2 (<2>) followed by the upper
case word LIVE and a trailing space.
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Live Scores: Footer
Daktronics scoreboards do not use a footer. White Way scoreboards use the End of Transmission control character, ASCII 4 (<4>).
Final Results: Header
Daktronics scoreboards use the same header for final results as for live scores. White Way scoreboards use a different header allowing them to
switch to the final results display automatically. In place of the word LIVE and a space, the header for final results starts with the same Start of
Transmission control character, ASCII 2 (<2>) followed by the upper case word FINAL.
Final Results: Footer
Both scoreboard types use the same footer for final results and live scores. For Daktronics, that is a blank footer. For White Way scoreboards it is
the single End of Transmission control character, ASCII 4 (<4>).
Test Buttons
Each header and footer includes a Test button. Pressing this button will let you know if your header or footer is valid or whether it is improperly
formatted.
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SK Flasher Tab
This tab is active only for ScoreKeeper Digital Flasher scoreboard definitions. It lets you control several aspects of the scoreboard display.
The flasher display consists of two separate displays. First is the score display where the results are displayed. The second is when clearing the
score display. There are options for both.
Display the gymnast name when showing the score
Check this to display the gymnast's name before showing the score final.
Names longer than eight characters will scroll the name twice before showing
the score. You can prevent this scrolling and display a truncated name instead
by setting the Name Size on the Data Settings tab to 8 characters.
Display individual judges' scores in addition to the final score
Check this if you want to show the score assigned by each individual judge
before showing the final score. The layout of the judge scores will be as in the
sample screen above with the judge number followed by the score.
What should be shown when clearing the display
You can completely blank the display, show the name of the event, or show the
name of the next gymnast to compete. If you elect to show the gymnast name,
the board will show the event name if all gymnasts in the rotation have
competed. If showing the gymnast name and the gymnast is an individual not
competing as part of a team, her team's short team name will be displayed
after her name.
Display Seconds
This is the number of seconds you can show the final score before the display
automatically clears to either a blank screen, the event name, or the next
gymnast's name. Set this to zero to disable automatic clearing. A button on the
score entry screen can be used to clear the display manually.
Display Colors
There are six different color settings that affect different components of either the score or clearing displays. Select red, green, or amber, the
colors available on these displays. The example screen will give you an idea of how the display will look.

DDE Interface
The DDE interface is a big enough topic that it merits a chapter of it's own. Read more about DDE in the chapter titled DDE Interface on page 103.
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XML Output
XML is an acronym standing for eXtensible Markup Language. That clears it up, right? It's really a text based way of organizing information by
tagging it with a series of names. ScoreKeeper generates an XML file and places it in a location of your choosing. The scoreboard system then reads
and interprets the file and displays the results.
While ScoreKeeper's XML output has more in common with its HTML web page generation than it does with the scoreboard functions, it is being
described here because XML is used mostly for controlling scoreboards. Just to keep it interesting, the XML settings are associated with the
program's global report settings in the program preferences:
Setup » Program Preferences » [Reports & XML tab]
The XML settings are at the bottom of the following screen.
Generate meet results as XML
Check this box to allow ScoreKeeper to create XML files containing
structured meet results data. When you check this box, the other
fields will become available. Checking this box also makes the choices
on the program's XML menu available as well.
Format the XML file for readability
XML data is designed for computers to read and write and computers
don't care if the information is presented in a nicely formatted
package or all scrunched together. For example, both of the
following are valid XML and are identical insofar as XML is concerned:
Unformatted
<meet name="OSU vs Utah" date="2009-03-01"><team name=
"Oregon State"><event name="Vault"><gymnast order="1"
firstname="Lisa" lastname="Miller" score="9.75"/><gymnast
order="2" firstname="Barbara" lastname="Smity"
score="9.85"/><gymnast order="3" firstname="Samantha"
lastname="Obama" score="9.80"/><gymnast order="4"
firstname="Alicia" lastname="McCain" score="9.85"/><gymnast
order="5" firstname="Jennifer" lastname="Jones"
score="9.85"/><gymnast order="6" firstname="Ashley"
lastname="Adams" score="9.90"/></event></team></meet>
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Formatted for readability
<meet name="OSU vs Utah" date="2009-03-01">
<team name="Oregon State">
<event name="Vault">
<gymnast order="1" firstname="Lisa" lastname="Miller" score="9.75"/>
<gymnast order="2" firstname="Barbara" lastname="Smity" score="9.85"/>
<gymnast order="3" firstname="Samantha" lastname="Obama" score="9.80"/>
<gymnast order="4" firstname="Alicia" lastname="McCain" score="9.85"/>
<gymnast order="5" firstname="Jennifer" lastname="Jones" score="9.85"/>
<gymnast order="6" firstname="Ashley" lastname="Adams" score="9.90"/>
</event>
</team>
</meet>
While the word-wrapping in this manual appears to retain enough structure to make it somewhat readable, the entire unformatted block would
actually be all on one very long line. In practice, the entire file would be one long line with no breaks, no indents, no formatting of any kind.
If you want to be able to look at the files and make sense of them, check the box. If you want smaller files which are just as readable to computers
(but not to people) leave it unchecked.
File Name
Enter here the name of the XML file you want ScoreKeeper to create. You can enter a literal file name or you can use the same tokens as for web
page files. These are shown on the Web Pages (1) tab on the same window.
NOTE: For compatibility with other programs, file names should always end in ".xml" (without the quotes).
XML Path
Enter here the location where you want ScoreKeeper to place the XML file. You can enter a path or do it the easy way by clicking the little ellipses
button to the right to lookup and select a folder. You can select a folder on your local computer or on any available network computer.
Override number of decimal places for scores
If you want to ignore the meet settings for the number of decimal places and use a set number of places, check this box and set the number of
decimal places to use.
Include the current rotation as Rotation 0
The XML file contains data for all rotations in order by rotation. Many systems that read XML files do not have the ability to extract only the
current rotation. If, in your setup, you want to use only the current rotation, check this box and the current rotation, whatever rotation number it
is, will be the first rotation shown and its number will be 0 (zero).
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Once you have your settings the way you want them, there are three ways that the XML file can be generated:
1. Manually by going to XML » Generate XML File Now
2. Automatically when a score is entered. For this to happen, there must be a check in the menu check box for XML » Enable XML File Generation.
3. Automatically based on a timer (see page 53)

XML File Structure
The XML files produced by ScoreKeeper are defined by another type of XML file, a "Schema." The schema for ScoreKeeper's files is called
ScoreKeeperMeet_2014_v3.xsd. A copy of this file is placed in the program folder and on the Beaver Creek Software web site at the following
address:
http://www.beaverlog.com/scorekeeper/download/ScoreKeeperMeet_2014_v3.xsd
All data in the ScoreKeeper XML meet output is presented as attributes rather than elements. Elements are used for structure and to contain the
attribute data. Attributes are the name and value pairs included within an element where the value is always within a pair of quotes. For example,
in the structure shown below, the sole attribute of the <session> element is number and it has the value of 1. Some elements have no attributes;
others can have as few as one attribute or several.
The basic structure is as follows, with most of the attributes omitted for clarity:
<meet>
<session number="1">
<rotations>
<rotation number="1">
<team event="1st event name">
<gymnast order="1" />
<gymnast order="2" />
...
</team>
<team event="2nd event name">
<gymnast order="1" />
<gymnast order="2" />
...
</team>
...
</rotation>
<rotation number="2">
...
</rotation>
</rotations>
<teamResults>
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<team place="1" />
<team place="2" />
...
</teamResults>
<eventResults>
<event name="1st event name">
<gymnast place="1" />
<gymnast place="2" />
...
</event>
<event name="2nd event name">
<gymnast place="1" />
<gymnast place="2" />
...
</event>
...
<event name="All Around">
<gymnast place="1" />
<gymnast place="2" />
...
</event>
</eventResults>
<session>
<meet>
This is a very simple representation of ScoreKeeper's XML structure. The ellipses indicate additional data of the same type as just presented. Most
meets have only a single session and the session number in these cases will be "all". In meets with two sessions, only one session is included in the
file and the session number will be 1 or 2. For the individual event finals meet at the national championships, there will be no rotations or team
results groupings, only the event results. If there are no all-arounders in a meet the event results for all around will not be present.
TIP:
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Video Interface
The fourth and final interface is by outputting
a video signal that is fed directly to either a
projection system or a video display. This is the
only interface where ScoreKeeper generates
the actual screens.
Using the ScoreKeeper video interface starts
with creating a "chain" of one or more screen
types. The chains are listed on the left side of
the screen and the screens for the highlighted
chain are listed on the right. There are two sets
of Add, Change and Delete buttons, one for
each list. In addition, the screens list has
buttons for Display Settings and View Sample.
When you add a screen to a chain, you can
select from the following screen types:
Team Results

Display team short name and current team total score. No event or gymnast details.

Team Details

Display the current event on which the team is competing. The screen includes the short team name, team event score, team
total score, competing gymnast names and their scores on the current event. If the team is not in the current rotation, it
shows the last event on which they competed.

Event Details

Cycling between events, this screen displays gymnasts that have competed on the event in descending score order. You can
choose how many "places" to include and the number of gymnasts per screen.

Graphic Image

Display a BMP, JPG or GIF image.

Alias

Re-displays another screen in the chain.

You can set the duration each screen will be displayed before it cycles to the next screen. The durations, in seconds are shown in the right-most
column.
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When you add a screen to a chain, you will get the window shown here on the right
to enter your settings.
The Edit Display Settings button is equivalent to the Display Settings button on the
previous list screen. Each screen type has a different collection of settings
appropriate to that screen type.

Team Results
The Team Results video screen displays teams by their short name and their
current team total score at once.
Background Image File
You can use an optional background image for your video screen. Enter a full path and file
name or click the button to select. You can select any of the following graphic file formats:
*.bmp
Bitmap or Windows Paint file
*.gif
Graphic Interchange Format
*.ico
Icon file
*.jpg
JPEG file
*.pcx
Paintbrush file
*.wmf
Windows Metafile
Image Alignment
You can choose how you want to align the background image. Your choices are:
Centered Center a graphic image on the screen.
Stretched Stretch a graphic image to fit the screen.
Tiled
Place as many copies of the graphic image as needed to fill the screen both
horizontally and vertically.
Teams per Screen
Select the number of teams to display on each screen. You can choose from 1 to 8 teams. If
there are more teams competing in the meet than the number per screen, the program will
cycle through all of the teams, one screen at a time.
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Background button
Click this button to set the background color for your video screen. If you are using a centered background image, this color will be visible outside
the borders of your image.
Name Color button
Click this button to select the font color used for team names.
Score Color button
Click this button to select the font color used for team scores.
Font button
This button lets you select the font and font size. If you also select a font color, it will reset both the name and score colors to your selected font
color.
Top Margin
This is padding, in screen pixels, at the top of the screen above the first team. The text itself has some padding built into the font selected so if
you enter a top margin of zero, the text will still start a few pixels down from the top of the screen.
Line Spacing
This is the distance, in screen pixels, between teams. No padding is added by the font so too small a value will cause the team lines to overlap.
Left Margin
This is the padding, in screen pixels, added to the left of the column of team names.
Right Margin
This is the padding, in screen pixels, added to the right of the column of team scores.
Screen Updates
Enter the number of seconds each block of teams will be displayed. This value and the number of seconds works with the number of seconds for
the screen as a whole. If you have four teams and are showing two teams per screen, the Team Results display will cycle between two screens of
two teams each. If each group of teams is shown for 10 seconds but your overall display time is 10 seconds or less, you will never see the second
block of teams.
Sort Teams By
Indicate whether you want to display the teams by name or by score, highest to lowest. When sorting by name, you can force the home team to
always be shown first by checking the checkbox labeled Show the home team first.
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View Sample Display Screen
The following keys can be used while viewing the sample Team Results video screen. Using keys to change spacings or the font size is the same as
changing the corresponding setting on the options screen but is much more convenient for fine-tuning the screen display.
Esc
F10
Ctrl+Up Arrow
Ctrl+Down Arrow
Ctrl+PgUp
Ctrl+PgDn
Ctrl+Left Arrow
Ctrl+Right Arrow
Shift+Left Arrow
Shift+Right Arrow
Alt+Up Arrow
Alt+Down Arrow
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Close the video screen window
Display the options window
Decrease line spacing (move text lines up)
Increase line spacing (move text lines down)
Decrease top margin (move all content up)
Increase top margin (move all content down)
Decrease right margin (move name column left)
Increase right margin (move name column right)
Increase left margin (move name column left)
Decrease left margin (move name column right)
Increase font size
Decrease font size
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Team Details
The Team Details video screen displays each team in the current rotation with one team
per screen. The layout can show up to six gymnasts on each screen. If there are more
than six gymnasts competing (exhibition performances are not displayed), the team will
be shown on multiple consecutive screens.
Each screen shows the team name in the top left with the team total running score on
the top right. This is followed by a delimiting line with the team gymnasts and their
event scores below the line. Gymnasts are listed in competition order and shown by
their last name. Below the gymnasts is a second delimiting line followed by the name of
the team's current event and their running score on that event.
Background Image File
You can use an optional background image for your video screen. Enter a full path and
file name or click the button to select. You can select any of the following graphic file
formats:
*.bmp
Bitmap or Windows Paint file
*.gif
Graphic Interchange Format
*.ico
Icon file
*.jpg
JPEG file
*.pcx
Paintbrush file
*.wmf
Windows Metafile
Image Alignment
You can choose how you want to align the background image. Your choices are:
Centered Center a graphic image on the screen.
Stretched Stretch a graphic image to fit the screen.
Tiled
Place as many copies of the graphic image as needed to fill the screen both horizontally and vertically.
Display Colors, Lines, and Font
Using the buttons, you can select the colors for the background, the team header, the gymnast name, and the scores. You can also select the
thickness of the line used to separate the header and footer parts from the gymnast details. Finally, you can select the font used for teams,
gymnasts, and scores.
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Position and Spacing
Use the top, left, and right margins and the line spacing to position the text where you want it.
Top Margin
This is padding, in screen pixels, at the top of the screen above the first team. The text itself has some padding built into the font selected so if
you enter a top margin of zero, the text will still start a few pixels down from the top of the screen.
Line Spacing
This is the distance, in screen pixels, between gymnasts. No padding is added by the font so too small a value will cause the gymnast lines to
overlap.
Header Spacing
This is like the line spacing above but is for the space between the team header and block of gymnasts and for the space between the block of
gymnasts and the event footer. These are the spaces occupied by the two delimiting lines.
Left Margin
This is the padding, in screen pixels, added to the left of the column of team names.
Right Margin
This is the padding, in screen pixels, added to the right of the column of team scores.
Top Line Position
This is the number of pixels from the top of the screen to the center of the top delimiting line.
Bottom Line Position
This is the number of pixels from the top of the screen to the center of the bottom delimiting line.
Time Between Screen Updates
This is the number of seconds the program waits between reading updated scores and displaying them. If the layout requires multiple screens to
display all of the teams, this is also the number of seconds between the different screens.
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Function Keys
The following keys can be used while viewing the Team Details video screen. Using keys to change spacings or the font size is the same as
changing the corresponding setting on the options screen but is much more convenient for fine-tuning the screen display.
Esc
Ctrl+Up Arrow
Ctrl+Down Arrow
Ctrl+PgUp
Ctrl+PgDn
Ctrl+Left Arrow
Ctrl+Right Arrow
Shift+Up Arrow
Shift+Down Arrow
Shift+PgUp
Shift+PgDn
Shift+Left Arrow
Shift+Right Arrow
Alt+Up Arrow
Alt+Down Arrow
Alt+PgUp
Alt+PgDn
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Close the video screen window
Decrease line spacing (move text lines up)
Increase line spacing (move text lines down)
Decrease top margin (move all content up)
Increase top margin (move all content down)
Decrease right margin (move name column left)
Increase right margin (move name column right)
Move the top separator line up
Move the top separator line down
Move the bottom separator line up
Move the bottom separator line down
Increase left margin (move name column left)
Decrease left margin (move name column right)
Increase font size
Decrease font size
Increase header and footer spacing
Decrease header and footer spacing
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Event Details
The event results screen shows results by event and includes all gymnasts (except
exhibitions) who competed on that event. This screen can be used for two different
situations. The screen is useful for displaying results for individual event finals at national
championships. For regular season meets, it can be used at the end of the meet to show
the "winners" of an event, and you can limit the display to only top scoring gymnasts.
Background Image File
You can use an optional background image for your video screen. Enter a full path and
file name or click the button to select. You can select any of the following graphic file
formats:
*.bmp
*.gif
*.ico
*.jpg
*.pcx
*.wmf

Bitmap or Windows Paint file
Graphic Interchange Format
Icon file
JPEG file
Paintbrush file
Windows Metafile

Image Alignment
You can choose how you want to align the background image. Your choices are:
Centered Center a graphic image on the screen.
Stretched Stretch a graphic image to fit the screen.
Tiled
Place as many copies of the graphic image as needed to fill the screen both
horizontally and vertically.
Background button
Click this button to set the background color for your video screen. If you are using a
centered background image, this color will be visible outside the borders of your image.
Header Color button
Click this button to select the font color used for team and event names.
Gymnast Color button
Click this button to select the font color for gymnast's names.
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Score Color button
Click this button to select the font color used for the team and gymnast's scores.
Line Color button
Click this button to select a display color for the delimiting lines.
Line Thickness
Set the delimiting line thickness in pixels. The actual thickness is shown with a sample line to the right of the thickness setting. Set the thickness to
zero to hide both delimiting lines.
Font button
This button lets you select the font and font size. If you also select a font color, it will reset both the name and score colors to your selected font
color.
Event Name
The event name is centered at the top of each screen. Indicate whether you want to display the short event name or the long version.
Top Margin
This is padding, in screen pixels, at the top of the screen above the first team. The text itself has some padding built into the font selected so if
you enter a top margin of zero, the text will still start a few pixels down from the top of the screen.
Line Position
This is the number of pixels from the top of the screen to the center of the line delimiting the event name from the block of gymnasts.
Line Spacing
This is the distance, in screen pixels, between teams. No padding is added by the font so too small a value will cause the team lines to overlap.
Header Spacing
This is like the line spacing above but is for the space between the team header and block of gymnasts and for the space between the block of
gymnasts and the event footer. These are the spaces occupied by the two delimiting lines.
Left Margin
This is the padding, in screen pixels, added to the left of the column of team names.
Right Margin
This is the padding, in screen pixels, added to the right of the column of team scores.
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Time Between Screen Updates
This is the number of seconds the program waits between reading updated scores and displaying them. If the layout requires multiple screens to
display all of the teams, this is also the number of seconds between the different screens.
Maximum Number of Gymnasts to Display per Screen
The title of this pretty much says it all. Valid settings are from 2 through 7.
Maximum Number of Places to Display per Event
Enter maximum the number of places to display. If you want to show only first, second, and third place, enter 3 here. Set this to 0 to include all
gymnasts competing on each event.
Function Keys
The following keys can be used while viewing the Event Results video screen. Using keys to change spacings or the font size is the same as
changing the corresponding setting on the options screen but is much more convenient for fine-tuning the screen display.
Esc
Ctrl+Up Arrow
Ctrl+Down Arrow
Ctrl+PgUp
Ctrl+PgDn
Ctrl+Left Arrow
Ctrl+Right Arrow
Shift+Up Arrow
Shift+Down Arrow
Shift+Left Arrow
Shift+Right Arrow
Alt+Up Arrow
Alt+Down Arrow
Alt+PgUp
Alt+PgDn
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Close the video screen window
Decrease line spacing (move text lines up)
Increase line spacing (move text lines down)
Decrease top margin (move all content up)
Increase top margin (move all content down)
Decrease right margin (move name column left)
Increase right margin (move name column right)
Move the top separator line up
Move the top separator line down
Increase left margin (move name column left)
Decrease left margin (move name column right)
Increase font size
Decrease font size
Increase header spacing
Decrease header spacing
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Graphic Image
The graphic image screen simply lets you display an image of your choice for a set number of seconds.
Background Image File

You can use an optional background image for your video screen. Enter a full path and file name or click the button to select. You can select any of
the following graphic file formats:
*.bmp
*.gif
*.ico
*.jpg
*.pcx
*.wmf

Bitmap or Windows Paint file
Graphic Interchange Format
Icon file
JPEG file
Paintbrush file
Windows Metafile

Image Alignment
You can choose how you want to align the background image. Your choices are:
Centered Center a graphic image on the screen.
Stretched Stretch a graphic image to fit the screen.
Tiled
Place as many copies of the graphic image as needed to fill the screen both horizontally and vertically.
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Background Color button
Click this button to set the background color for your video screen. If you are using a centered background image, this color will be visible outside
the borders of your image.
Alias
The Alias screen type is simply a way for you to re-use one of your other screens without having to adjust all of the settings.

Other than the display time, there are no display settings specifically for the Alias screen type. On the list,
Alias Screen
Select the screen you want to display again in the new order in the chain.
Display Time
The alias screen lets you select a different number of seconds than the original display time. Don't know why you would want to but you can.
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7. Flasher Displays
Video Flashers
NOTICE: The Video Flasher interface is available only for those who have
purchased two or more ScoreKeeper Video Flasher displays.
Beaver Creek Software offers tripod based units with three video screens that are set up at each event and connected to ScoreKeeper Remote.
These units can display a variety of screens from the name of the currently competing gymnast to the individual judge scores, the final score, and
even a graphic image (think advertising). Setup for these screens is in the main ScoreKeeper program but ScoreKeeper Remote is where you display
them and control what is displayed.
IMPORTANT: In order to run the video flashers, there are three conditions for the computer running
ScoreKeeper Remote:
1. The computer must have an HDMI port to connect to the Video Flasher unit.
2. The computer must be capable of displaying information on two monitors with the second
monitor being the flasher unit connected to the HDMI port.
3. In Windows Control Panel, you must have enabled the second monitor on that computer.
We cannot give specific instructions for setting up a dual display because the process is somewhat different for each version of Windows. However,
it is usually easy to do. Just be sure that you select the option to extend the display, not duplicate or mirror the display. When the display is
extended, it's as if the second monitor was an extension to the first and connected to the right of the regular display.
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Display Chains
The Show Inactives check box in the upper right lets you see chains
that you have made inactive.
Adding a display chain is as simple as clicking the
give you the following screen.

button and will

You will notice that there is not much in the way of settings on this
screen.

Chain Name
The chain name is for your convenience so you can tell one chain from another. ScoreKeeper doesn't use this for anything except showing it to
you on the list of available display chains.
Home Team
If you have multiple home teams (i.e. men's and women's teams), select the home team this chain applies to.
Active
This check box lets you set whether the chain is active. Inactive chains are normally hidden on the list but remain in the system in case you want
to use them in the future.
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Display Settings
The Display Settings button is where all the real setup
happens and you can access these settings for the
highlighted chain by clicking the Display Settings
button.
When you open the display settings, it starts with you
selecting which of the many screen types you want to
display in the chain. For all but two of those screens
(event name and gymnast name), you also enter the
number of seconds the screen will be shown before
advancing to the next screen in the chain.
You can select either the separate start value and
judge score screens or the combined start value &
score screen so if the check box for the combined
screen is checked, the other two are not available. If
either of the separate start value and judge score
screens are checked, the combined screen check box
will not be available. That is the case on the example
screen on the right.
Each of these screens is discussed below. But first a
few words about fonts.
Display Fonts
We have tested a lot of fonts and font sizes for readability in a large arena and have concluded that the best font to use is Arial Narrow Bold in
point sizes from around 400 to 600. It is a compromise between using the tallest font and still fitting it in the width. By using a narrow font, you can
use larger font sizes and still fit them on the display. Bold fonts make the narrow ones a bit wider but make them more readable from a distance.
We tried both serif and sans-serif fonts and sans-serif fonts are much more readable. Here are some examples.

9.975 9.975 9.975 9.975
Arial Narrow
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Arial Narrow Bold

Arial Bold

Times New Roman Bold
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Event Screen
This screen simply displays the event name. It is often
useful to include this screen and leave the event name
on the display until that event starts and the beginning
of the meet.
The three buttons do just what they say and let you set
the background color, font (and size), and font color
respectively. The image on the right gives you a rough
idea how it will look but the size of the font you select
is not reflected in the sample, only the font face and
colors are representative.
Green Flag Screen
If you choose to use it, the green flag screen can take
the place of the judge raising the green flag to signal to
the gymnast that it's okay to start their routine.
As of this writing, the rules for NCAA gymnastics give
the gymnast 30 seconds to begin once the green flag
has been raised. You have the option to show the
number of seconds as a countdown timer. The number
of seconds is set on the Selection tab.
Because the program has no way to automatically
know when the gymnast actually starts his or her
routine, it is up to the ScoreKeeper Remote operator to
close the green flag screen and advance to the next
screen, usually the gymnast's name.
Gymnast Name Screen
In addition to font and colors, you can set the vertical
position for the name and how to display it. You can
scroll names across the screen if they are too wide to
fit or you can have ScoreKeeper automatically adjust
the font size so that the name will always fit. Scrolling
can cause screen flicker so test it on your system first.
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Judge Screen
The Judge screen has two separate and independently
adjustable screen objects: the word JUDGE and a
number indicating which judge assigned the scores
shown on the following screen which will be either:
1. the combo screen showing both the start value
and score assigned by the judge or
2. The separate start value screen and/or judge
score screen.
You can select a single background color and separate
font, font color, and positions for the two screen
objects. Because this starts a small loop through all of
the judges for the event, you can select the minimum
number of times each judge will be displayed before
moving on to subsequent screens.
Notice that the Judge and Number positions are
negative numbers. Numbers less than zero move things
up from the starting position.
Combo Screen
This screen can be used with or without the judge
screen above because a judge number can be included
in the labels for the start value and judge score. This
screen has four screen objects, two labels and two
scores. The labels can be blank which would leave only
the two scores. In that case, you would use the judge
screen to show the judge number and use a larger and
wider font for the start value and score.
You can set the left and right margins to move the
labels and scores respectively and you can set the
vertical positions for the score and start value lines.
With these you can even place the start value above
the score.
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Start Value Screen
The start value is sometimes referred to as the
difficulty. If you include this screen, it is used in
conjunction with the Judge screen and the Judge Score
screen as a trio that cycles through each of the judges
on the event. Typically you would set the font color to
something darker and more subdued than the score
screen so that the score stands out more than the start
value.
Though you seldom have to account for them in other
uses, fonts have a built-in space above the visible
characters so you may need to use a negative vertical
position to position the start value vertically.
Judge Score Screen
This screen should always be used along with the Judge
Screen and, optionally, the Start Value Screen. In either
case, think of the two or three screens as a group that
cycles through all of the judges on an event.
Using the check box, you can tell ScoreKeeper to
continue cycling through the judges until the operator
signals the display to switch to displaying the final
score.
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Final Score Screen
The Final Score Screen is just what is says. This screen
should be sized and colored to be the most prominent
of the score screens, especially if you are using the
separate Judge Score and Start Value screens.
Continue judge scores once final score is displayed
This check box tells the program to continue showing
the loop showing the individual judge scores and start
values but to add the final score to the loop after the
last judge. If you are not showing individual judge
results, this check box doesn't do anything.

Graphic Image Screen
This screen will display a graphic image, no big surprise.
You can use it to show your school's logo or perhaps
earn some cash for your program by displaying a
company's ad or logo.
You can automatically display this screen following the
final score by checking the box below the background
color.
Image File
You can select an image file from any of the following
graphic file formats:
*.bmp
Bitmap or Windows Paint file
*.gif
Graphic Interchange Format
*.jpg
JPEG file
*.pcx
Paintbrush file
*.wmf
Windows Metafile
You will want to use a graphic image that matches the size of your display. 1080p High Definition screens are 1920 x 1080 pixels while 720p High
Definition screens are 1280 x 720 pixels. Images that are at or just a bit smaller than those limits work best.
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8. DDE Interface
ScoreKeeper provides a DDE interface that allows another program running on the same computer to enter scores and retrieve results. DDE is a
Windows protocol that allows two programs to communicate with each other. As in the serial output interface, the actual display of the data using
DDE is entirely up to the scoreboard system.
To enable the DDE interface in ScoreKeeper is a simple matter of starting a DDE Server window in ScoreKeeper that waits for requests from the client
program and processes them. The ScoreKeeper window will display both the request and the response. The requests are either to add scores to
ScoreKeeper or ask ScoreKeeper for a specific piece of data, for example the team scores for one team or the scores for one gymnast on a team. In
the first instance, ScoreKeeper takes the data, calculates the results, and stores it in the database where it can be used for updating a web page or
any other typical output. In the second case, where the client program asks for results, ScoreKeeper replies with the requested data.
ScoreKeeper retains the most recent 200 requests and responses but this number can be changed by modifying the MaxDDELines setting in the
[ScoreEntry] section of the SkSet.ini configuration file. This file can be opened by going to Help » About ScoreKeeper and clicking on the Information
button. This opens the Support Information screen. Click the button at the bottom labeled Edit INI File.
In addition to displaying the requests and responses, you can also have this information sent to a text file. This can be helpful in resolving any
problems that arise. If you want the technical details of the DDE interface to ScoreKeeper, contact Beaver Creek Software.

Entering Scores via DDE
To enable score entry through a DDE interface, you first have to set the scoreboard interface in the Program Preferences (Setup » Program

Preferences) to DDE. Next, you have to open ScoreKeeper’s DDE server (Scoreboard » Open DDE Server).

The DDE Server display window is most useful for technical support people trying to track down problems, though you might find it interesting to
watch for a minute or so. You can minimize the screen by pressing the window minimize button:
If you close the DDE Server window, it will stop all communications with the Elite scoreboard program and reopening the screen will not reestablish
the link. The Elite scoreboard program will have to be restarted or reinitialized after reopening the DDE Server window in ScoreKeeper.
That’s all you have to do on the ScoreKeeper end. Please refer to the documentation for your Elite scoring system for information on using their
equipment and software.
Normally ScoreKeeper automatically updates your meet web page and your display scoreboard when scores are entered and entering scores via DDE
does not do this. If you want to automatically generate web pages and/or output information to a display scoreboard, use the Timed Output option
on the File menu or the button on the tool bar. This option is discussed on page 53.
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Technical Information
This document will not teach you how to use DDE. It assumes you know how to write a program that can communicate via DDE. The information
presented here describes the interface and data structures provided by ScoreKeeper and used to communicate between the DDE client and server.
You can enter scores or query score, gymnast, team, or score information using a DDE client. Dynamic Data Exchange (DDE) is a Microsoft Windows
protocol for exchanging data between programs or processes. One program or process is the "Server" and the other is the "Client." ScoreKeeper
presents a DDE Server interface and communicates via the following four data structures:
To establish DDE communications, ScoreKeeper uses the following parameters:
Application Name
Topic Name:
Topic Name:
Topic Name:
Topic Name:
Topic Name:

ScoreKeeper
GymnastScores
TeamScores
TeamsList
EventInfo
MeetInfo

Used for all DDE communications
Entering and querying gymnasts and scores
Querying team information including team scores
Querying team information without scores
Querying event information
Querying meet information

Number Formats
When submitting a gymnast's scores, the format of the score is flexible. Leading and trailing zeros or spaces are ignored if present. Thus, the score
can be left or right aligned anywhere within the score field.
When scores are returned to a client program, there will be no leading zeros, although there can be leading and trailing spaces and trailing zeros
depending on the number of decimal places to display. This is set in the Meet setup.
When making a request using either a gymnast or team number in the DDE Item, these are integer strings and leading zeros are ignored. Trailing
spaces are also ignored.
Entering Scores
DDE Type:
DDE Topic:

DDE Item

Poke
GymnastScores

EnterScore

Score data is sent to ScoreKeeper using the ScoreEntry structure using the DDE Poke command with the DDE Item string being the literal string
"EnterScore" (not case sensitive and without the quotes). It is important that the GymnastNumber string contain the valid assigned gymnast
number because this is how the gymnast is identified by the ScoreKeeper DDE Server.
ScoreEntry
GymnastNumber
Event
Performance

DDE Interface

GROUP
STRING(4)
STRING(1)
STRING(1)

! gymnast number
! Event number (e.g. 1=Vault, 2=Bars, 3=Beam, 4=Floor)
! 1=First, 2=Second
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Order
Judge1
Judge2
Judge3
Judge4
Judge5
Judge6
Judge7
Judge8
ND
DScore

STRING(2)
STRING(5)
STRING(5)
STRING(5)
STRING(5)
STRING(5)
STRING(5)
STRING(5)
STRING(5)
STRING(4)
STRING(5)
END

! competition order if filled
! score from judge 1, <#.##
! score from judge 2, <#.##
! score from judge 3, <#.##
! score from judge 4, <#.##
! score from judge 5, <#.##
! score from judge 6, <#.##
! score from judge 7, <#.##
! score from judge 8, <#.##
! neutral deduction, #.##
! D score, <#.##

If the Order field is filled and is different than the competition order previously set up in ScoreKeeper, the competition order in ScoreKeeper will be
changed to match the new value. If this gymnast was already listed in the lineup in a different order, the gymnast who was previously in the new
order position will be switched with the new gymnast. If the current gymnast was not previously in the lineup, the gymnast in that lineup slot will be
taken out of the lineup and replaced with the new gymnast.
Gymnast Information
DDE Type:
DDE Topic:
DDE Item

Request
GymnastScores
Gymnast's assigned number

The GymScore structure is used to query gymnast information using the DDE Request command with the DDE Item containing the gymnast's
assigned number as a string.
GymScore
GymnastNumber
TeamNumber
TeamCompeting
FirstName
LastName
Event1
Event2
Event3
Event4
Event5
Event6
AllAround
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GROUP
STRING(4)
STRING(2)
STRING(1)
STRING(20)
STRING(20)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
END

! gymnast number, <<<#
! system assigned team number, <#
! is this gymnast's team competing as a team? (0 or 1)
! gymnast first name
! gymnast last name
! score for event 1, <#.####
! score for event 2, <#.####
! score for event 3, <#.####
! score for event 4, <#.####
! score for event 5, <#.####
! score for event 6, <#.####
! all-around score, <#.####
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Team Information
DDE Type:
DDE Topic:
DDE Item

Request
TeamScores or TeamsList
Arbitrary team number, system assigned

Team information may be queried with a DDE Request with the DDE Item containing a team number. Teams are numbered from 1 to the number
of teams in the meet. In meets that have gymnast's competing as individuals, non-competing teams are present if they have a gymnast competing
in the meet. These non-competing teams are identified with a zero in the Competing field.
A list of teams can be assembled by looping through the teams starting with team number 1 and continuing to increment the team number with
each iteration of the loop until a negative DDE Acknowledgement is returned for an unknown team number.
When using the TeamsList topic, the score fields will be empty but the response will be faster because ScoreKeeper does not have to look up scores
for each event. Use this topic when assembling your team list. If you use TeamScores, it will include scores. Since it takes a little longer to get the
scores, you have the choice of which request to use. Otherwise, both use the same data structure.
Data eturned using the requesting topic, either TeamScores or TeamsList uses the following data structure.
TeamScore
TeamNumber
Competing
TeamName
ShortName
TeamEvent1
TeamEvent2
TeamEvent3
TeamEvent4
TeamEvent5
TeamEvent6
TeamTotal

GROUP
STRING(@n2)
STRING(1)
STRING(50)
STRING(10)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
STRING(7)
STRING(8)
END

! <#
! 1 for competing teams, 0 for non-competing teams
! long team name
! short team name
! team score on event 1, <#.####
! team score on event 2, <#.####
! team score on event 3, <#.####
! team score on event 4, <#.####
! team score on event 5, <#.####
! team score on event 6, <#.####
! team total score, <<#.####

Event Information
DDE Type:
DDE Topic:
DDE Item

Request
EventInfo
Event number

You can query event information using the EventInfo data structure. The DDE Item should contain the number corresponding to the event. Events
are normally in "Olympic" order which for women's gymnastics is Vault, Bars, Beam Floor. For men's gymnastics the order is Floor, Pommel Horse,
Rings, Vault, Parallel Bars, and Hi Bar. These orders are the defaults but can be changed in ScoreKeeper so do not rely on the default order.
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If you request an event number greater than the number of events, a negative DDE Acknowledgement will be returned. This allows you to loop
through numbers until you get a negative Acknowledgement to find all of the events.
EventInfo
Number
Performances
Abbreviation
ShortName
LongName

GROUP
STRING(1)
STRING(1)
STRING(2)
STRING(10)
STRING(30)
END

!example:
2
!0 or 1 (e.g. one or two vaults)
!example:
UB
!example:
Bars
!example:
Uneven Parallel Bars

Meet Information
DDE Type:
DDE Topic:
DDE Item

Request
MeetInfo
not used, ignored

You can query meet information using the MeetInfo data structure. The DDE Item is not used and is ignored.
MeetInfo
Name
Location
Type
Date
Sex
Competitors
ScoresToCount
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GROUP
STRING(50)
STRING(50)
STRING(1)
STRING(8)
STRING(1)
STRING(2)
STRING(2)
END

!Meet name
!Meet location
!1 = Team meet, 2 = Individual meet
!yyyymmdd
!M or W
!Number of team competitors per event (right aligned)
!Number of scores to count toward team total (right aligned)

END
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9. Miscellaneous
Customizing Your Web Pages
Two things must be in place for ScoreKeeper to generate web pages from your meet. The first is that you must select a name and location for the
page. That is done on the Program Preferences screen. See page 5 for more information. The second is that you must enable web page generation.
This is done by clicking on Web Pages » Enable Web Page Generation. This puts a blue check mark next to the menu option. Click the menu again to
turn it off and remove the blue check.
ScoreKeeper has several options that allow you to control the content and appearance of your web pages.
IMPORTANT:

You may not remove the Beaver Creek Software name, copyright notice,
web link, or telephone numbers from the bottom of generated web pages.

Page Colors
You can select the colors that will be used when generating your web pages. This is on the program preferences screen: Setup » Program
Preferences (see page 14).
Include Files
ScoreKeeper can include the contents of files you customize much like a word processing program does a mail merge. These are text files
containing HTML code and should be free of any <html>, <head>, <body>, or their related closing tags. Beyond these limitations, ScoreKeeper does
not limit what these files contain so you can include JavaScript code, style sheets, or other special code.
There are several specifically named include files which, if used, must reside in the program folder (usually c:\Program Files\ScoreKeeper): When
ScoreKeeper creates a web page, it looks for these files and if a file is found, it will be included at that place in the generated page. To see exactly
where in the web page file each include file’s contents would be placed, look at a generated web page file and search for comment lines such as <!- include file location for HTMLHead2.htm -->. If an include file of that name was found, you will see a pair of comments, one before the include
file contents and one after in the form: <!--Start if include file: PageBody2.htm--> before the included contents and <!--End if include file:
PageBody2.htm--> after. For each group of three include files below, the first is used by the live scores web pages, the second is for the home team
stats web pages, and the third is for the honor roll web page.
HTMLStart.htm
StatsStart.htm
HonorStart.htm
Inserted at the beginning of the file, immediately after the <html> tag.
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HTMLHead1.htm
StatsHead1.htm
HonorHead1.htm
Inserted near the beginning of the file, immediately after the <head> tag.
StyleSheet.htm
StatsStyle.htm
HonorStyle.htm
This is where you add your style sheet reference if using the same cascading style sheet for all three page types. You can then use one of the
following three includes to override a style for a particular page type. Note this include file will not be processed if you do not have style sheets
enabled in the program preferences screen.
HTMLHead2.htm
StatsHead2.htm
HonorHead2.htm
Inserted near the beginning of the file after ScoreKeeper's <title> and several <meta> tags. Use one of these includes to reference a style sheet
that is designed for just one of the page types (meet results, stats, or honor roll). If you are overriding just a couple of the styles for a general style
sheet you can reference a separate style sheet file place the style definitions here directly.
HTMLHead3.htm
StatsHead3.htm
HonorHead3.htm
Inserted immediately before the <body> tag.
PageBody1.htm
StatsBody1.htm
HonorBody1.htm
Inserted immediately after the <body> tag.
PageBody2.htm
StatsBody2.htm
HonorBody2.htm
Inserted immediately after the <body> tag. For backward compatibility, the meet results web pages let you use PageHead.htm here as well. If
both PageBody2.htm and PageHead.htm are present, PageHead.htm will be included first.
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PageBody3.htm
StatsBody3.htm
HonorBody3.htm
Inserted after the page title and subtitle and before everything else.
PageFoot.htm
StatsFoot.htm
HonorFoot.htm
Inserted at the end of the page just before Beaver Creek Software's copyright notice.
To place your school logo at the top of the page, create a text file named PageHead.htm in the program folder and include a link to your logo file.
The link must be to a logo file on your web server.
NOTE: If any of your include files refer or link to a graphic or other file, the
referenced file must exist in the location specified in your include file.

Cascading Style Sheets
Ordinarily, the web pages generated by ScoreKeeper include all layout and color information. You can use the page colors described above to make
your web pages more closely fit with your teams other web pages but your choices are limited. To really create a consistent look, you need to use
styles. Styles are descriptions of various elements of the web page and indicate such things as height, width, position, margins, foreground and
background colors, and many other properties of each element.
Styles can be placed directly in a page but this is inefficient and makes it hard to change the appearance of a group of pages. Instead, styles should
be stored in their own file or files and a reference to the style files can then be added to the web page. By convention, style sheet files have the file
extension .css.
The topic of cascading style sheets is far too large to describe here but there are many books and web references to help you design your style
sheets. Just search on CSS on the web and you'll find more than you have time to read.
If you want to use style sheets in your ScoreKeeper generated web pages, there are three things you must do:
1. Enable styles by checking the Format web pages with CSS on the program preferences screen (Setup » Program Preferences). This changes the
way ScoreKeeper creates web pages by removing all of the formatting and adding names (class and id) to various page elements.
2. Create your style sheet or modify one of the sample style sheets placed in your program folder.
3. For a general style sheet that is used for all page types, place a reference to your style sheet in StyleSheet.htm. To use a separate style sheet
for each page type, place the style sheet references in HTMLHead2.htm, StatsHead2.htm, and HonorHead2.htm.
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The styles included in ScoreKeeper web pages should be mostly self-explanatory to anyone familiar with style sheets. However, there are some
styles that are dynamic and are different for each team in the meet. These dynamic styles are always in the "id" rather than "class" styles.
In the Team Standing table (id="standing_table"), each row uses a dynamic id style corresponding to the compressed short team name. The
compressed short team name uses the short team name you enter in ScoreKeeper for that team and removes all non-alpha characters. For
example, a short team name of "O.S.U." would become "OSU". The dynamic id values are "standing_row_XXX" where the XXX represents the short
team name with any spaces and other non-alphanumeric characters removed..
The Team Detail tables (class="team_table") have dynamic id values equivalent to the compressed short team name. In addition, the table captions
(class="caption") have id values corresponding gain to the compressed short team name (id="team_caption_XXX").
The event results tables (class="event_table") have id values equivalent to the compressed short event name. These are usually in all upper case
except for all around which, by default, is "AllArr". These short event names can be changed in ScoreKeeper so be sure to match the style to the
exact short event name and, for most web servers, case is important so Vault is different than VAULT.
ScoreKeeper tables use a different class value for alternating rows. Odd numbered rows have the class value of "row_1" while even numbered rows
have a class value of "row_2". Exceptions nclude the title table (id="title_table") where the rows are not numbered and the table of contents table
(id="contents_table") where the row classes for the odd and event rows are named "contents_row_1" and "contents_row_2" respectively. This is
designed to allow the contents table to be displayed differently than other tables.
The event results tables use a variation of the alternating rows in that the rows id values change only when the placing changes. So if there is a tie
for first place, the first two rows would have id values of "row_1" and the third row would have an id value of "row_2". Another variation is in the
list of meet judges (id="judge_table") where the head judge in each event has a class value of "row_1" while the remaining judges have a class
value of "row_2".
NOTE: The ScoreKeeper installation places two sample style sheets and some graphics they reference in
the Styles subfolder under your program folder. You can use these as is or change them to suit
your institution's web style.
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Exporting and Importing a Meet
In the File menu, you will find two entries that let you copy a single meet to another computer. The Export This Meet menu selection will export all of
the information from the currently selected meet into a portable file that you can take to another computer or give to your visiting teams for them
to import into their copy of ScoreKeeper.
When you import a meet, you select the
export file and ScoreKeeper presents
you with the following screen.
Most of the options will be set correctly
by default but, if you are importing an
away meet, you will probably have to
select your home team in the list of
meet teams. Once you do this, the
program attempts to match your home
team gymnasts with the gymnasts in the
team you selected. If the names are an
exact match, the list will look like the
example above. If some gymnast's
names were misspelled or entered
incorrectly in the away meet, these
names will appear in the Unassigned
Meet Gymnasts list. Select a gymnast
from this list and highlight the
corresponding home team gymnast and
click on the
button.
Click the ok (green check mark) button
to import the meet. After you import an
away meet, you should edit the meet
and change the name and opponent so
that these are from your home team's
point of view.
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10. Utility Programs
ScoreKeeper Remote
ScoreKeeper Remote is a companion program that allows you to enter scores for one selected event at that event rather than all scores being
entered on one computer at a central location. In large meets such as regional and national championships, this can greatly reduce the load on the
main computer operator, freeing them to handle inquiries, corrections, lineup changes, printing results, and so on.
In addition to being able to enter scores for an event locally at that event, ScoreKeeper Remote can also output the score results to either the
ScoreKeeper Video Flasher or ScoreKeeper Digital Flasher at that event.
Read the User Guide for ScoreKeeper Remote for more information.

ScoreKeeper Viewer
ScoreKeeper Viewer is a companion program to and part of the Gymnastics ScoreKeeper. It allows you display live meet results on a computer or
television type screen. This gives you the capability to use a video display scoreboard that has the ability to capture screen output and display it for
fans. It also lets you show the live data to press or others you designate. The user can select fonts and font size, as well as the font color and
background color of the results screens.
Read the User Guide for ScoreKeeper Viewer for more information.
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11. Digital Flasher Scoreboards
ScoreKeeper Flasher display scoreboards are single line displays for showing the scores entered at each event. They can replace all manual score
flashers or can work with the manual flashers and display only the final score on the event. ScoreKeeper Flasher boards can be connected to a single
computer or to a computer at each head judge's table running ScoreKeeper Remote.

Scoreboard Definitions
Scoreboard definitions are covered in detail on page 72. This chapter will discuss only those features that apply to ScoreKeeper Flasher scoreboards.
Most of the options for scoreboard definitions do not apply to ScoreKeeper Flasher scoreboards. However a few will determine what information is
displayed.
General Tab
Include scores from the first meet and totals for both meets.
This option only affects the second meet of a two-meet series. For ScoreKeeper Flasher scoreboards checking this option will cause the total score
for two meets to be displayed after showing the final score for the current meet. It will not cause the scoreboard to display the score from the
first meet.
Data Settings Tab
Name Format
All of the name formats are supported but may display differently. When the name is eight characters or fewer in length, the name will display
immediately. When longer than eight characters, the name will scroll by twice before the judge scores are displayed. The recommended setting is
to display the last name only.
Name Size
Since names longer than eight characters will scroll rather than displaying immediately, you can force all names to be shown immediately by
limiting the size to 8 characters. If an occasional scrolling name does not bother you, leave this at its maximum size. If you select a name format of
last name only, it will never be longer than 20 characters.
Score Display Decimals
Individual judge scores are always shown with two decimal places. Final average scores can have as many as five decimal places. The
recommended setting is three decimal places.
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Event Size
After cycling between a gymnast's name and scores, the display can be reset to the name of the event. The event's short name is used for the
display and while the short name can up to ten characters, the display will only show eight without scrolling so an event size of eight is
recommended.
Show individual judges' scores in addition to a final score
When checked, the scoreboard will first show the gymnast's name, followed by each judge's score, followed by the final average score. It will then
cycle back to the gymnast's name. When not checked, the display cycles only between the gymnast's name and final average score; individual
judge's scores are not shown.

Reprogramming Scoreboard Address
Each ScoreKeeper Flasher scoreboard is programmed to recognize data sent to a
particular numeric address. In both ScoreKeeper and ScoreKeeper Remote, you can
reprogram a board's address from the Scoreboard menu by selecting Change Board
Address.
To reprogram an address in the scoreboard, you must first know its current address.
When you receive the scoreboard first turn it on, the scoreboard is in a demo mode
showing its communication speed, address, and all of its display capabilities. Once a
board has received data, these boards remember whatever they last displayed even if
the power is removed and will show the same information next time the power is turned
on.
You may not know the address programmed into a board and it may not show it because it is displaying the last data sent to it. Fortunately, any
board will respond to a command sent to address 0 (zero) regardless of the board's programmed address. Thus you can enter zero for the old
address and the desired address in the new address field. Clicking the Change Board Address button will program the new address into all
connected boards.
You can clear the display and return the board to its initial demo mode using one of the Clear buttons. As in changing the board address, by using
address zero, all connected boards will be cleared. If you press one of the shifting keys (Shift, Ctrl, or Alt) while clicking one of the Clear buttons,
the board will be cleared to the event name if one has been selected. If no event has yet
been selected the board will show the word, "Event."
ScoreKeeper stores scoreboard addresses in the Event record. The initial address values
are listed on the right.
These addresses can be changed in the main ScoreKeeper program but this only changes
the address to which ScoreKeeper sends the data and may or may not match the
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Women's Event
Vault
Uneven Parallel Bars
Balance Beam
Floor Exercise

Address
1
2
3
4

Men's Event
Floor Exercise
Pommel Horse
Rings
Vault
Parallel Bars
Horizontal Bar

Address
1
2
3
4
5
6

Page 115

address stored in the display hardware. If the address ScoreKeeper sends to does not match the address programmed into the board, the display
will not be updated.

Chain ScoreKeeper Flasher Scoreboards
The scoreboard connects to a computer via a 9-pin serial port (RS-232) using a normal, straight-through cable (not a null-modem cable). The back of
the board has two 9-pin connectors: one male and one female. Connect the cable from the computer to the female connector on the scoreboard.
The male connector on the scoreboard can be used to run a cable to another scoreboard in "daisy-chain" fashion. Based on the addresses
programmed in to the scoreboards, chained scoreboards can display different information or the same information.
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12. Troubleshooting
Ordinarily ScoreKeeper should be easy to understand and to use. However, it contains several connections to hardware and systems largely outside
its control and sometimes it can be a challenge to find and correct problems with these systems when they occur. This chapter is here to help with
some of the more common difficulties users have. It is organized into questions and answers. Many of the answers are themselves questions to
which you will have to find the answers.

Will my scoreboard work with ScoreKeeper?
This is a big question with many complex answers. To answer it in detail, we will break it down into several smaller questions that are, hopefully,
easier to answer.

Does ScoreKeeper support my scoreboard?
ScoreKeeper supports scoreboards from Daktronics, White Way Sign Company, and Elite Technologies. ScoreKeeper supports and has been tested
with Daktronics Venus 6000 and later controllers. Some earlier controllers may work but this has not been tested.
Support for White Way boards requires an interface program from White Way. Contact your representative to obtain the necessary software.
Elite Technologies makes scoreboards, controller, and handheld input devices. ScoreKeeper supports these via DDE, an acronym for Dynamic Data
Exchange which is a Windows protocol for passing data between disparate programs. We worked with Elite to create this interface in which
ScoreKeeper is a DDE server. Elite provides a DDE client program that communicates with ScoreKeeper and allows their system to input scores and
query the results.

Is the scoreboard enabled in ScoreKeeper?
The first thing to do is tell ScoreKeeper how to communicate with the scoreboard. On the Scoreboard tab of the program preferences (Setup »
Program Preferences, see page 7), you select Serial Communications for Daktronics and White Way and DDE for Elite scoreboards.
If you are using an Elite system, skip to "Verifying DDE Communications" below.
For Daktronics, White Way, or other serial interface scoreboard systems, go to the meet setup, on the Output tab, select the scoreboard definition
to use. If no definition is selected, then ScoreKeeper will not output data to a scoreboard.
Once a scoreboard definition is selected for a meet, make sure that the "Enable Live Scoreboard" is checked on the Scoreboard menu. This tells
ScoreKeeper to send scoreboard data when each score is saved. When this is not checked, you can still send scoreboard data by selecting "Display
Live Data" menu option to send the data one time.
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Is there communication between ScoreKeeper and your scoreboard?
Both Daktronics and White Way scoreboards receive data from ScoreKeeper via an RS-232 serial port interface. ScoreKeeper assembles the meet
results as a structured block of data then sends that block to the scoreboard over the serial cable. Sometimes there is a small transmitter box near
the ScoreKeeper computer that boosts the signal so that it can communicate over the relatively long distance to the scoreboard controller
computer. The first thing to check is whether you are using the correct communications port. Different computers and different versions of
Windows let you see the computers port settings in different ways. Usually the easiest is to get to the Device Manager. If you right click on My
Computer either on your desktop or in Windows Explorer, and select Properties. Usually on the Hardware tab, you will find a button that opens the
Device Manager. That will give you a list of all hardware components in your computer. Expand the Ports listing and you will see both parallel (LPT)
and communications (COM) ports. Look for the port numbers (COM1, COM2, etc.). This will tell you what ports your computer has available. In
some earlier versions of Windows, there was a Ports icon in your Windows Control Panel that would give you the same information.
On most computers, you can enable or disable COM ports in the BIOS settings. To get to these settings, you have to press a special key when your
computer is starting up. There is usually a message that appears briefly on the screen that tells you to press the key to enter Setup. It is usually
either the Del, F1, or F2 key but could be something else.
Once you know what port or ports your computer has available, you can set ScoreKeeper to use that port. On the Scoreboard tab of the program
preferences (Setup » Program Preferences, see page 7), you can set the port and the other communications settings.
The Serial Communications settings, with the possible exception of the Port number, must match the settings on the scoreboard controller that
receives the data sent by ScoreKeeper. If any of these are different, the two computers cannot communicate with each other.
When ScoreKeeper creates the block of data to send to the scoreboard computer, it can also write this block to a text file you can use to verify that
something is being generated. On the same Program Preferences screen, check the box labeled Send scoreboard results to a file and enter a path
and file name for the file. Each time results are sent, this file is overwritten with the new data.
If you are connecting to a transmitter box, make sure the box is getting electrical power. You can often verify that data is getting to the box by
watching the lights on the box at the moment you send the scoreboard data. One or more of them should blink when data is being received, at
least as far as the transmitter box. If no lights blink then perhaps you are connected to the wrong COM port.
The scoreboard controller may have the ability to view the raw data as it is received. This lets you know that data is getting to the controller. If your
controller software doesn't have this capability, you should be able to run another communications program to see the data as it comes in. The
HyperTerminal program comes with Windows and is ideal for this task. There are also many free and low cost programs available if HyperTerminal
is not present. Just be sure to set the communications speed, parity, data bits and stop bits appropriately in whatever software you are using.

Are you using the correct data layout?
In ScoreKeeper, the structure of the data block that is sent to the scoreboard is controlled by the scoreboard definition selected for the meet (see
page 72). Here you can set the size and style of gymnast names, the number of decimal places for scores, etc. If these are different from what the
scoreboard controller is expecting, the data will come through but will appear scrambled on the scoreboard. You can print a report showing the
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exact layout of the data for a given scoreboard definition and meet type. This report can then help you design your scoreboard display. For
Daktronics, ScoreKeeper can also generate an ITF file that is used by Daktronics controllers to define the data layout. It contains the same
information as the layout report but can make your display setup very much easier.

Verifying DDE Communications
Elite Technologies systems communicate with ScoreKeeper via DDE. In order for ScoreKeeper to receive scores from Elite Technologies controllers,
you first have to set the scoreboard interface in the Program Preferences (Setup » Program Preferences » Scoreboard tab) to DDE. Next, you have to
open ScoreKeeper’s DDE server (Scoreboard » Open DDE Server).
The DDE Server window will show you all of the DDE transactions between the Elite program and ScoreKeeper. It shows both successful
transactions and error transactions. You can minimize this window during normal ScoreKeeper operations but if you close it, all communications
with the Elite scoreboard program will cease.
The DDE Server window retains the most recent 200 lines but this number can be changed by modifying the MaxDDELines setting in the ScoreEntry
section of the SkSet.ini configuration file. This file can be found in the Windows folder (may be named WinNT or Win2K on some computers).
How Can I get my ScoreKeeper Flasher Board to Display?
ScoreKeeper Flashers are small scoreboards that will show gymnast names and scores for an event. They connect to your computer via an RS-232
serial port cable and are most commonly controlled by the ScoreKeeper Remote program rather than the main ScoreKeeper program. Nonetheless,
most of the settings for Flasher boards are accessible only from within the main program.
The scoreboard definitions for Flasher boards, is different than for other scoreboards. Some of the data settings are used (see page 74) but neither
the Final Results nor the Header & Footer tabs are enabled. Instead, the SK Flasher tab (see page 79) is available for settings that apply only to
Flasher boards. None of these, however, determine whether the display will actually show results, only how it will display. Still, it is a good idea to
review them.

Have you Licensed SK Flasher?
Unless you have purchase the ScoreKeeper Flasher boards from Beaver Creek Software or have purchased the Flasher license for boards purchased
elsewhere, none of the Flasher menus will be enabled.

Is the Board Address Correct?
Each Flasher board is programmed with an address, a number from 1 and 8. Each flasher communication includes the address number and only
boards with that address will react to that communication. Transmissions sent to address 0 (zero) will be recognized by all boards and this is useful
if you do not know what address is set to. When the boards are new, they are set to address 1 and the current address is usually displayed briefly
when you first plug the board into the electrical power. You can reprogram the address easily from within ScoreKeeper or ScoreKeeper Remote
(see page 115). By default, each event transmits on a different address. Tables for men's and women's events and their default addresses can be
found on page 115. You can change the address for an event by changing the event record itself in ScoreKeeper (Setup » Events).
Troubleshooting

Page 119

Are the Communications Settings Correct?
When you first power up a Flasher board, its communications settings are displayed. The initial values are 9600 Baud, no parity, eight data bits, and
one stop bit. These are also the default values in ScoreKeeper. In ScoreKeeper Remote, go to the Scoreboard menu and select Scoreboard Setup (

Is the Flasher Definition Selected?
If you are controlling the Flasher boards from the ScoreKeeper main program, you must select a ScoreKeeper Flasher definition for the meet's
scoreboard output. If you are using ScoreKeeper Remote, you must check the box labeled "Send scores to a ScoreKeeper Flasher scoreboard" on
the Scoreboard Setup screen. You must also select the appropriate Flasher scoreboard definition on the same screen.

Is the Cable Plugged Into the Correct Flasher Connector?
Flasher boards have two 9-pin serial connectors, one male and one female. The female connector is the input to the board from the ScoreKeeper
computer. The male connector is an output and allows you to chain multiple Flasher boards in series.

How Do I Put a Meet Results Web Page on the Web?
First check the settings for web pages in the program preferences, Setup » Program Preferences. On the Web Pages (1) tab you can enter a name for
the web page file. You can enter a literal name such as "Meet Results.htm" or let ScoreKeeper assign the name based on the meet date using
tokens. For example +C+Y+M+D.htm will create a file named 20060316.htm for a meet on March 16, 2006. You can also set the path where the file
will be created.
Lower down on the program preferences screen, you can indicate whether the program puts the HTML header in the file. Some sports web sites
put their own header on web pages and don't want headers on the pages you send.
The Seconds for HTML refresh is a setting that is placed within the web page file that will cause browsers to re-read the page as often as the setting
you enter in ScoreKeeper. This lets users watching the results from home to avoid having to manually refresh their screen.
The "Minutes between automatic generation" setting determines whether a new web page is created based on a timer or whenever a score is
entered. If the minutes is set to zero, the page will be recreated every time you enter a score. Otherwise it will use a timer based on the number of
minutes you enter.
The settings on the Web Pages (2) tab let you make the colors on the generated pages match your school colors. You can also set whether to add a
list of the meet judges at the end of the page.
Next, edit your home team settings, Setup » Home Teams » [Select Team] » Internet tab. The only critical entries here are in the FTP Login and FTP Live
Scores Web Page boxes and possibly the Advanced FTP Options button. These settings are unique to every web host and you may need to get them
from your internet service provider.
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Assuming that all the above setup is entered correctly, then you have to make sure that Enable Web Page Generation is checked on the Web Pages
menu. In Windows Explorer, you can look at the file date and time of the web page to see that it was changed when you expected. You can also
double click this file to view it in your browser.
If you want ScoreKeeper to upload the page to your web site via FTP, they you must also check the Enable Web Page Uploads on the Web Pages
menu.
When a web page is generated, if an error occurs, Enable Web Page Generation is unchecked to prevent further error messages. If the error
happens while uploading the page, Enable Web Page Uploads is unchecked. If you have corrected the error, be sure to check these boxes again.
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